Oracle® Business Intelligence Data Warehouse Administration Console Guide

Version 7.9
February 2007
The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS. Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle, JD Edwards, PeopleSoft, and Siebel are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.
Contents

Chapter 1: What’s New in This Release

Chapter 2: Overview of Oracle Business Analytics Warehouse
Oracle Business Analytics Warehouse Overview 9
Oracle Business Analytics Warehouse Architecture 10
   Oracle Business Analytics Warehouse Architecture Components 11
About the Data Warehouse Administration Console 12
About Source System Containers 15
   About DAC Repository Objects 16
   About the DAC Process Life Cycle 17

Chapter 3: DAC Quick Start

Chapter 4: Overview of the DAC Interface
Navigating the DAC Interface 22
The DAC’s Menu Bar 23
The DAC’s Views 26
The DAC’s Top Pane Toolbar 27
The DAC’s Right-Click Menus 28
The DAC’s Server Monitor Icons 33
The DAC’s Navigation Tree 34
The DAC’s Editable Lists 34
Using the DAC Query Functionality 35
   DAC Query Commands and Operators 35
   DAC Query Examples 36
   Common DAC Query Procedures 36
   Using Flat Views Querying 37
About Object Ownership in the DAC 38
Chapter 5: Customizing, Designing, Executing and Monitoring ETL Processes

Creating or Copying a Source System Container 41
About Customizing the Data Warehouse 42
Adding a New Table and Columns to the Data Warehouse 44
Adding an Index to the Data Warehouse 46
Importing New Data Warehouse Objects into the Informatica Repository 46
Creating Informatica Mappings and Workflows 46
Creating Tasks in the DAC for New or Modified Informatica Workflows 47
Setting a Task Phase Dependency 48
Creating a Task Group 49
Setting Source System Parameters 49
Setting Task Level Parameters 50
Working with Configuration Tags 51
Considerations in Designing a Subject Area 54
Creating a Subject Area 56
Building and Running an Execution Plan with the DAC 57
Creating a Micro ETL Execution Plan 58
Scheduling an Execution Plan 60
About Refresh Dates 60
Monitoring Execution Plan Processes 61

Chapter 6: Common Tasks Performed in the DAC

Importing DAC Metadata 63
Exporting DAC Metadata 64
Distributing DAC Metadata 65
Running the DAC Server Automatically 65
Command Line Access to the DAC Server 66
  Setting Up Command Line Access to the DAC Server 67
  Using the Command Line to Access the DAC Server 68
DAC Repository Command Line Options 70
Replacing an Informatica Workflow with a Custom SQL File 72
## Contents

Determining the Informatica Server Maximum Sessions Parameter Setting 73
Determining the Number of Transactional and Data Warehouse Database Connections 75
Running Two DAC Servers on the Same Machine 75
Customizing Index and Analyze Table Syntaxes 76
Using SQL Files as an Execution Type in the DAC 77
Overview of Change Capture Process (Siebel Sources Only) 78
  Initial Data Capture 79
  Change Capture Mechanisms 79
Using the Change Capture Filter 84
Tracking Deleted Records 84
Handling ETL Failures with the DAC 86

### Chapter 7: DAC Functional Reference

Common Elements of DAC Interface Tabs 89

About the DAC Design View 89
  About the DAC Subject Areas Tab 90
  About the DAC Tables Tab 92
  About the DAC Indices Tab 94
  About Advanced Custom Index Management 96
  About the DAC Tasks Tab 97
  About the DAC Task Groups Tab 102
  About the DAC Configuration Tags Tab 105
  About the DAC Source System Parameters Tab 106
  About the DAC Source System Folders Tab 106

About the DAC Setup View 106
  About the DAC System Properties Tab 107
  About the Informatica Servers Tab 111
  About the Physical Data Sources Tab 112
  About the Email Recipients Tab 114

About the DAC Execute View 114
  About the DAC Execution Plans Tab 115
  About the DAC Current Run Tab 119
  About the DAC Run History Tab 122
  About the DAC Scheduler Tab 122

## Index
Oracle Business Intelligence Applications consists of components that were formerly available from Siebel Systems as Siebel Business Analytics Applications (both CRM and Enterprise) with a number of significant enhancements.

The Oracle Business Intelligence Data Warehouse Administration Console Guide contains information about using the Data Warehouse Administration Console (DAC), a centralized console for schema management as well as configuration, administration, loading, and monitoring of the Oracle Business Analytics Warehouse.

Oracle recommends reading the Oracle Business Intelligence Applications Release Notes before installing, using, or upgrading Oracle Business Intelligence Applications. The Oracle Business Intelligence Applications Release Notes are available:

- On the Oracle Business Intelligence Applications CD-ROM.

**What’s New in Oracle Business Intelligence Data Warehouse Administration Console Guide, Version 7.9**

The Oracle Business Intelligence Data Warehouse Administration Console Guide is a new guide in Release 7.9. Some of the information in this guide was previously published in the *Siebel Business Analytics Applications Installation and Administration Guide*. 
Overview of Oracle Business Analytics Warehouse

This chapter provides an overview of the Oracle Business Analytics Warehouse and the Data Warehouse Administration Console (DAC). It includes the following topics:

- Oracle Business Analytics Warehouse Overview on page 9
- Oracle Business Analytics Warehouse Architecture on page 10
- About the Data Warehouse Administration Console on page 12
- About Source System Containers on page 15

Oracle Business Analytics Warehouse Overview

The Oracle Business Analytics Warehouse is a unified data repository for all customer-centric data. The purpose of the Oracle Business Analytics Warehouse is to support the analytical requirements of Oracle Business Intelligence Applications.

The Oracle Business Analytics Warehouse includes the following:

- A data integration engine that combines data from multiple source systems to build a data warehouse.
- An open architecture to allow organizations to use third-party analytical tools in conjunction with the Oracle Business Analytics Warehouse using the Oracle Business Intelligence Server.
- Prebuilt data extractors to incorporate data from external applications into the Oracle Business Analytics Warehouse.
- A set of ETL (extract-transform-load) processes that takes data from multiple source systems and creates the Oracle Business Analytics Warehouse tables.
- The DAC, a centralized console for schema management as well as configuration, administration, loading, and monitoring of the Oracle Business Analytics Warehouse.
Figure 1 provides an overview of the Oracle Business Analytics Warehouse.

### Oracle Business Analytics Warehouse Architecture

High-level analytical queries, like those commonly used in Oracle Business Analytics Warehouse, scan and analyze large volumes of data using complex formulas. This process can take a long time when querying a transactional database, which impacts overall system performance.

For this reason, the Oracle Business Analytics Warehouse was constructed using dimensional modeling techniques to allow for fast access to information required for decision making. The Oracle Business Analytics Warehouse derives its data from operational applications, and uses Informatica’s data integration technology to extract, transform, and load data from transactional databases into the Oracle Business Analytics Warehouse.
Figure 2 illustrates how the Oracle Business Analytics Warehouse interacts with the other components of Oracle BI Applications.

Oracle Business Analytics Warehouse Architecture Components

The Oracle Business Analytics Warehouse architecture comprises the following components:

- **DAC client.** A command and control interface for the data warehouse to allow for schema management, and configuration, administration, and monitoring of data warehouse processes. It also allows you to design subject areas and build execution plans.
DAC server. Executes the instructions from the DAC client. The DAC server manages data warehouse processes, including loading of the ETL and scheduling execution plans. It dynamically adjusts its actions based on information in the DAC repository. Depending on your business needs, you might incrementally refresh the Oracle Business Analytics Warehouse once a day, once a week, once a month, or on another similar schedule.

DAC repository. Stores the metadata (semantics of the Oracle Business Analytics Warehouse) that represents the data warehouse processes.

Informatica Server. Loads and refreshes the Oracle Business Analytics Warehouse.

Informatica Repository Server. Manages the Informatica repository.

Informatica Repository. Stores the metadata related to Informatica workflows.

Informatica client utilities. Tools that allow you to create and manage the Informatica repository.

About the Data Warehouse Administration Console

The DAC provides a framework for the entire life cycle of data warehouse implementations. It allows you to create, configure, execute, and monitor modular data warehouse applications in a parallel, high-performing environment. For information about the DAC process life cycle, see “About the DAC Process Life Cycle” on page 17.
The DAC complements the Informatica ETL platform. It provides application-specific capabilities that are not prebuilt into ETL platforms. For example, ETL platforms are not aware of the semantics of the subject areas being populated in the data warehouse nor the method in which they are populated. The DAC provides these application capabilities at a layer of abstraction above the ETL execution platform, as illustrated in Figure 3.

Figure 3. DAC Application-Specific Capabilities
Important DAC Features

Important DAC features allow you to do the following:

**Minimize install, setup, and configuration time**
- Create physical data model in the data warehouse
- Set language, currency, and other settings
- Design subject areas and build execution plans

**Manage metadata driven dependencies and relationships**
- Generate custom ETL execution plans
- Automate change capture for the Siebel transactional database
- Capture deleted records
- Assist in index management
- Perform dry runs and test runs of execution plans

**Provide reporting and monitoring to isolate bottlenecks**
- Perform error monitoring and email alerting
- Perform structured ETL analysis and reporting

**Utilize performance execution techniques**
- Automate full and incremental mode optimization rules
- Set the level of Informatica session concurrency
- Load balance across multiple Informatica servers
- Restart from point of failure
Queue execution tasks for performance (See Figure 4.)

The DAC manages the task execution queue based on metadata driven priorities and scores computed at runtime. This combination allows for flexible and optimized execution.

---

**About Source System Containers**

Source system containers hold repository objects that correspond to a specific source system. For information about the different kinds of repository objects, see “About DAC Repository Objects” on page 16.

You can use the preconfigured source system containers to create your own source system container. You cannot modify objects in the preconfigured source system containers. You must make a copy of a preconfigured container in order to make any changes to it.

For instructions on creating a new source system container or copying an existing container, see “Creating or Copying a Source System Container” on page 41.
About DAC Repository Objects

All DAC repository objects are associated with a source system container. For more information about source system containers, see “About Source System Containers” on page 15 and “About Object Ownership in the DAC” on page 38.

The DAC repository stores application objects in a hierarchical framework that defines a data warehouse application. The DAC allows you to view the repository application objects based on the source system container you specify. The source system container holds the metadata that corresponds to the source system with which you are working.

A data warehouse application comprises the following repository objects:

- **Subject area.** A logical grouping of tables related to a particular subject or application context, as well as the tasks that are associated with the tables. Subject areas are assigned to execution plans, which can be scheduled for full or incremental loads. A subject area also includes the tasks required to load the subject area tables.

- **Tables.** Physical database tables defined in the database schema. Can be transactional database tables or data warehouse tables. Table types can be fact, dimension, hierarchy, aggregate, and so on, as well as flat files that can be sources or targets.

- **Task.** A unit of work for loading one or more tables. A task comprises the following: source and target tables, phase, execution type, truncate properties, and commands for full or incremental loads. When you assemble a subject area, the DAC automatically assigns tasks to it. Tasks that are automatically assigned to the subject area by the DAC are indicated by the Autogenerated flag in the Tasks child tab of the Subject Areas tab.

- **Task Groups.** A group of tasks that you define because you want to impose a specific order of execution. A task group is considered to be a “special task.”

- **Execution plan.** A data transformation plan defined on subject areas that needs to be transformed at certain frequencies of time. An execution plan is defined based on business requirements for when the data warehouse needs to be loaded. An execution plan comprises the following: ordered tasks, indices, tags, parameters, source system folders, and phases.

- **Schedule.** A schedule specifies when and how often an execution plan runs. An execution plan can be scheduled for different frequencies or recurrences by defining multiple schedules.
About the DAC Process Life Cycle

The DAC is used by different user groups to design, execute, monitor, and diagnose execution plans. These phases together make up the DAC process life cycle, as shown in Figure 5.

The phases of the process and the actions associated with them are as follows:

- **Setup**
  - Set up database connections
  - Set up ETL processes (Informatica)
  - Set up email recipients

- **Design**
  - Define application objects
  - Design execution plans

- **Execute**
  - Define scheduling parameters to run execution plans
  - Access runtime controls to restart or stop currently running schedules

- **Monitor**
  - Monitor runtime execution of data warehouse applications
  - Monitor users, DAC repository, and application maintenance jobs
In order to start the DAC client, you must have completed the steps shown in Figure 6.

![DAC Quick Start Flow](image)

Figure 6. DAC Quick Start Flow
For instructions on installing the Oracle BI Infrastructure, see the *Oracle Business Intelligence Infrastructure Installation and Configuration Guide*. For instructions on completing the remaining steps, see the *Oracle Business Intelligence Applications Installation and Configuration Guide*. 
4 Overview of the DAC Interface

This chapter contains the following topics:

- Navigating the DAC Interface on page 22
- The DAC’s Menu Bar on page 23
- The DAC’s Views on page 26
- The DAC’s Top Pane Toolbar on page 27
- The DAC’s Right-Click Menus on page 28
- The DAC’s Server Monitor Icons on page 33
- The DAC’s Navigation Tree on page 34
- The DAC’s Editable Lists on page 34
- Using the DAC Query Functionality on page 35
- About Object Ownership in the DAC on page 38
Navigating the DAC Interface

Figure 7 shows the main elements of the DAC window.

![Example of DAC Window]

Figure 7. Example of DAC Window
The DAC’s Menu Bar

Table 1 provides a description of the DAC’s menu bar options:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>The File menu contains options to close the DAC client and to create, copy, or delete source system containers. For instructions on creating or copying a source system container, see “Creating or Copying a Source System Container” on page 41.</td>
</tr>
<tr>
<td>Views</td>
<td>The Views menu allows you to navigate to the various tabs in the top pane window.</td>
</tr>
<tr>
<td>Tools</td>
<td>The Tools menu provides access to functionality related to the DAC and Informatica repositories. Table 2 provides a description of the Tools menu commands.</td>
</tr>
<tr>
<td>Help</td>
<td>The Help menu provides details about the current DAC login as well as the version of DAC metadata and software. There is no online help for the DAC.</td>
</tr>
</tbody>
</table>
Tools Menu Options

Table 2 provides a description of the Tools menu commands.

### Table 2. DAC Tools Menu Commands

<table>
<thead>
<tr>
<th>Tools Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| DAC Repository Management > Export | Allows you to export the DAC metadata, in XML format, based on the source system container, in order to back up the metadata or to reproduce the environment elsewhere. In the Export dialog box, you can specify a directory in which to store the XML file or accept the default directory, which is DAC\export. In the Export dialog box, you can select the following category options:  
  - **Logical.** Exports all information contained in the Design view and database connection information.  
  - **Run Time.** Exports all information contained in the Execute view.  
  - **System.** Exports all information contained in the Setup view, except passwords for servers and database connections. |
| DAC Repository Management > Import | Allows you to import the DAC metadata for the source system containers you specify. In the Import dialog box, you can specify the following:  
  - **Import/Export folder.** A directory from which to import the data. The default directory is DAC\export.  
  - **Truncate repository tables.** Indicates whether you want to truncate the repository tables. If you select this option, the existing metadata is overwritten.  
  - **Enable batch mode.** Indicates whether batch mode is enabled, which inserts the imported metadata into the repository as an array insert. In the Import dialog box, you can select the following category options:  
  - **Logical.** Imports all information contained in the Design view and database connection information.  
  - **Run Time.** Imports all information contained in the Execute view.  
  - **System.** Imports all information contained in the Setup view, except passwords for servers and database connections. |
## Overview of the DAC Interface

### The DAC’s Menu Bar

Oracle Business Intelligence Data Warehouse Administration Console Guide

### Table 2. DAC Tools Menu Commands

<table>
<thead>
<tr>
<th>Tools Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| DAC Repository Management > Create Repository Report                                | Allows you to generate a DAC repository report based on the following criteria:                                                                                     | - Table Row Counts  
- Object References by Entity  
- Ownerless Objects  
- Unreferenced Objects  
- Dead References  

The Clean Up command removes unused referenced objects.  

<table>
<thead>
<tr>
<th>Tools Menu Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| DAC Repository Management > Purge Run Details                                       | Allows you to purge completed runs from the run history. You can purge all runs (except the last run) or specify particular runs to be purged. The last run cannot be purged. In the Purging Runs... dialog box, the following options are available:                                                                                                                                            | - **All.** Purges all completed runs except for the last run.  
- **By Execution Plan.** Allows you to select an execution plan whose associated runs you want to purge.  
- **By Run Name.** Allows you to select an individual run for purging.  
- **Before Specified Date.** Allows you to select a date before which all runs except the last run will be purged.  
- **Details Only.** Purges all related information about a run but leaves the run header information.  

<table>
<thead>
<tr>
<th>Tools Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAC Repository Management &gt; Analyze Repository Tables</td>
<td>Allows you to run analyze table commands for all the DAC repository tables.</td>
</tr>
<tr>
<td>DAC Repository Management &gt; Default Index Properties</td>
<td>Allows you to specify which databases will be associated with newly created indices.</td>
</tr>
<tr>
<td>DAC Repository Management &gt; Drop DAC Repository</td>
<td>Allows you to drop all the DAC repository tables. This action deletes all data in the repository.</td>
</tr>
<tr>
<td>DAC Server Management &gt; Get Server Log</td>
<td>When the DAC server is running an ETL process, this command opens a text box that displays streaming data related to the process.</td>
</tr>
<tr>
<td>DAC Server Management &gt; DAC Server Setup</td>
<td>Allows you to configure the DAC server connections and server email settings. This action should be performed on the machine where the DAC server is running.</td>
</tr>
</tbody>
</table>
The DAC’s Views

The DAC’s View buttons are located directly under the menu bar. Table 3 provides a description of the different DAC Views.

Table 3. DAC Views

<table>
<thead>
<tr>
<th>Design</th>
<th>The Design view provides access to functionality related to creating and managing subject areas. For more information, see “About the DAC Design View” on page 89.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source System Container Drop-Down List</td>
<td>When the Design view is active, the Source System Container drop-down list appears to the right of the View buttons. It allows you to select the source system container that holds the metadata corresponding to a source system.</td>
</tr>
<tr>
<td>Setup</td>
<td>The Setup View provides access to functionality related to setting up DAC system properties, Informatica servers, database connections, and email notification. For more information, see “About the DAC Setup View” on page 106.</td>
</tr>
<tr>
<td>Execute</td>
<td>The Execute view provides access to functionality related to setting up, running, monitoring, and scheduling execution plans. For more information, see “About the DAC Execute View” on page 114.</td>
</tr>
</tbody>
</table>

Table 2. DAC Tools Menu Commands

<table>
<thead>
<tr>
<th>Tools Menu Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETL Management &gt; Configure</td>
<td>Opens the Data Warehouse Configuration wizard, which allows you to create and drop data warehouse tables and to create delete triggers.</td>
</tr>
<tr>
<td>ETL Management &gt; Reset Data Warehouse</td>
<td>Clears the refresh dates for all source and target tables. This action forces a full load to occur.</td>
</tr>
<tr>
<td>Seed Data &gt; Task Phases</td>
<td>Allows you to add, edit, or delete task phases.</td>
</tr>
<tr>
<td>Seed Data &gt; Task Folders</td>
<td>Allows you to add, edit, or delete task folders.</td>
</tr>
<tr>
<td>Seed Data &gt; Logical Data Sources</td>
<td>Allows you to add, edit, or delete logical data sources.</td>
</tr>
<tr>
<td>UI Styles &gt; Windows (MFC)</td>
<td>Changes the user interface to the Windows style.</td>
</tr>
<tr>
<td>UI Styles &gt; UNIX (MOTIF)</td>
<td>Changes the user interface to the UNIX style.</td>
</tr>
<tr>
<td>UI Styles &gt; Java (METAL)</td>
<td>Changes the user interface to the Java style.</td>
</tr>
</tbody>
</table>
The DAC’s Top Pane Toolbar

Table 4 describes the commands available in the top pane toolbar.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a placeholder for a new record in the selected list.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current record.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undoes changes made to the current record after the last save.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected record. If you delete a parent record, the child</td>
</tr>
<tr>
<td></td>
<td>records are also deleted.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> When you delete a column from a table, the column is not</td>
</tr>
<tr>
<td></td>
<td>automatically deleted from the index.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The DAC does not display deleted objects. You must look at the</td>
</tr>
<tr>
<td></td>
<td>database to figure out what objects were deleted.</td>
</tr>
<tr>
<td>Query</td>
<td>Opens a blank query.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Retrieves the data from the repository with the last used query.</td>
</tr>
<tr>
<td>Reference</td>
<td>Design view only. Opens the Reference dialog box, which allows you to</td>
</tr>
<tr>
<td></td>
<td>copy objects from one container to another. For more information about</td>
</tr>
<tr>
<td></td>
<td>referencing objects, see “About Object Ownership in the DAC” on page 38.</td>
</tr>
<tr>
<td>Assemble</td>
<td>Design view only. Assembles a subject area, with dimension and related</td>
</tr>
<tr>
<td></td>
<td>tables as well as tasks.</td>
</tr>
<tr>
<td>Drop-down list</td>
<td>Design view only. Allows you to filter the source system container</td>
</tr>
<tr>
<td></td>
<td>objects that appear in the top pane list.</td>
</tr>
<tr>
<td>Run Now</td>
<td>Execute view, Execution Plans tab only. Starts a new ETL process.</td>
</tr>
<tr>
<td>Start</td>
<td>Execute view, Current Run and Run History tabs only. Restarts the selected</td>
</tr>
<tr>
<td></td>
<td>ETL, after the ETL has failed, stopped, or been aborted.</td>
</tr>
<tr>
<td>Stop</td>
<td>Execute view, Current Run and Run History tabs only. Stops an ETL in</td>
</tr>
<tr>
<td></td>
<td>progress. All currently running tasks will complete, and queued tasks will</td>
</tr>
<tr>
<td></td>
<td>stop. The status of the ETL changes to Stopped.</td>
</tr>
<tr>
<td>Abort</td>
<td>Execute view, Current Run and Run History tabs only. Causes an ETL in</td>
</tr>
<tr>
<td></td>
<td>progress to abort. All currently running tasks will be aborted. The status</td>
</tr>
<tr>
<td></td>
<td>of queued tasks and the ETL itself will change to Stopped.</td>
</tr>
<tr>
<td>Auto Refresh</td>
<td>Execute view, Current Run tab only. Allows you to turn on and off the</td>
</tr>
<tr>
<td></td>
<td>automatic screen refresh functionality and set the refresh interval.</td>
</tr>
</tbody>
</table>
The DAC’s Right-Click Menus

The commands available in the right-click menus depend on the tab that is active. For descriptions of the commands, see the following topics:

- Common Right-Click Menu Commands on page 29
- Design View Right-Click Menu Commands on page 30
- Setup View Right-Click Menu Commands on page 31
- Execute View Right-Click Menu Commands on page 32
# Common Right-Click Menu Commands

Table 5. Common Right-Click Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy String</td>
<td>Copies the contents of a cell (editable and read-only) to the clipboard</td>
</tr>
<tr>
<td>Paste String</td>
<td>Pastes a string from the clipboard into a selected cell that supports a string data type.</td>
</tr>
<tr>
<td>Copy Record</td>
<td>Creates a copy of the selected record, with a unique record ID. The new record is committed to the database when you click the Save button or click outside the cell.</td>
</tr>
<tr>
<td></td>
<td>In the Design view tabs (except for the Indices tab), Copy Record copies the selected record and the record’s child records. When you copy a subject area, the tables are also copied but the tasks are not copied. You need to use the Assemble command to reassemble the subject area and add tasks to it.</td>
</tr>
<tr>
<td></td>
<td>In the Design view Indices tab and Setup and Execute views, Copy Record copies only the selected record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected record. If you delete a parent record, the child records are also deleted.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> When you delete a column from a table, the column is not automatically deleted from the index. You must manually delete columns from indices that were deleted from a table or else the ETL process will fail.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The DAC does not display deleted objects. You must look at the database to figure out what objects were deleted.</td>
</tr>
<tr>
<td>Output to File</td>
<td>Outputs to a text file in the DAC root folder the contents of the current tab’s record list.</td>
</tr>
<tr>
<td>Record Info</td>
<td>Displays the record’s unique ID, object type, current source system, owner source system, and the timestamp for when it was last updated. It also displays the source system lineage and the source systems that reference the object.</td>
</tr>
<tr>
<td>Update Records</td>
<td>For some columns, allows you to update the column value for each row to a single value.</td>
</tr>
</tbody>
</table>
## Design View Right-Click Menu Commands

Table 6. Design View Right-Click Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| Ownership                | **Reference.** Opens the Reference dialog box, which allows you to reference objects from one container to another. The reference function works like a symbolic link or shortcut.  
**Re-Reference.** If an object is a referenced object, that is, a reference to an object in another container and a change is made to the original object’s child objects, you can use this command to import the changes to the referenced object.  
**Push to References.** If an original object is changed, you can use this command to export the changes to all referenced objects’ child objects.  
**De-Clone.** When you make changes to a referenced object, the new object is called a clone. This command allows you to revert a cloned object back to its state as a reference.  
**Re-Assigned Record.** This command allows you to reassign an object’s ownership. For more information about the ownership of objects, see “About Object Ownership in the DAC” on page 38. |
| Assemble                 | Assembles a subject area, with dimension and related tables as well as tasks.                                                                   |
| Generate Index Scripts   | Generates drop index, create index, and analyze table scripts for all tables that participate in the ETL process. The results are stored in the log\scripts directory. |
| Change Capture Scripts   | **Image and Trigger Scripts.** Generates change capture scripts for tables with defined image suffixes. The scripts may include delete triggers, create and drop statements for delete triggers, and image tables and their indices.  
**View Scripts.** Generates change capture view scripts for full or incremental mode for tables that participate in the change capture process. This command can be used for unit testing.  
**Change Capture SQL.** Generates change capture SQL scripts for full or incremental mode for tables that participate in the change capture process. This command can be used for unit testing. |
Overview of the DAC Interface  ■ The DAC’s Right-Click Menus

Table 6. Design View Right-Click Menu Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| Import from Database  | ■ **Import Database Tables.** Allows you to import table definitions from a selected database. This action does not import columns.  
                      | ■ **Import Indices.** Allows you to import index definitions from a selected database for one or more tables as listed in the result of the query.  
                      | ■ **Import Database Columns.** Allows you to import column definitions from a selected database. |
| Filter Indices        | Allows you to filter by database type the indices that are displayed in the top pane list. |
| Output Task Description| Saves to an HTML file the description for a selected task or for all tasks. |
| Synchronize Tasks     | Synchronizes the information the DAC has for a task’s source and target tables with the information in the Informatica repository. |
| Flat Views            | Opens a dialog box that allows you to query for various objects, modify data, and do mass updates.  
                      | You can query for the following objects:  
                      | **Tables tab:**  
                      | ■ Related Tables  
                      | ■ Table Columns  
                      | **Indices tab:** Index columns  
                      | **Tasks tab:**  
                      | ■ Task Source Tables  
                      | ■ Task Target Tables  
                      | ■ Task Conditional Tables  
                      | ■ Task Phase Dependencies  
                      | ■ Task Parameters  

Setup View Right-Click Menu Commands
### Overview of the DAC Interface

#### The DAC’s Right-Click Menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Connection</td>
<td>In the Physical Data Sources tab, it allows you to test the database connection. In the Informatica Servers tab, it allows you to test the connection to the Informatica Server and Repository Server. The DAC server performs this command if the DAC client is connected to a server. If the DAC client is not connected to a DAC server, then the DAC client performs the command.</td>
</tr>
</tbody>
</table>

**Table 7. Setup View Right-Click Menu Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark as Completed</td>
<td>Changes the status of a stopped or failed ETL to Completed. In the audit trail for this ETL, the status is Marked as Completed. Use this command with caution; it can cause the data warehouse to be inconsistent.</td>
</tr>
<tr>
<td>Get Run Information &gt; Get Log File</td>
<td>Fetches the log file for this run from the DAC server and saves it in the ServerLog folder.</td>
</tr>
<tr>
<td>Get Run Information &gt; Analyze Run</td>
<td>Saves a description of the run as an HTML file in the Log/Statistics folder.</td>
</tr>
<tr>
<td>Get Run Information &gt; Get Chart</td>
<td>Displays a chart showing changes in task statuses over time in a separate window.</td>
</tr>
<tr>
<td>Get Run Information &gt; Get Graph</td>
<td>Displays a graph showing changes in task statuses over time in a separate window.</td>
</tr>
</tbody>
</table>

**Table 8. Execute View Right-Click Menu Commands**
Overview of the DAC Interface

The DAC’s Server Monitor Icons

The Server Monitor is located in the upper-right corner of the DAC client. Its color and shape change based on the DAC server status. When the DAC client cannot establish a connection to the DAC server, the Server Monitor icon resembles a red electrical plug. When the client is connected to the server and the server is idle, the icon resembles an orange electrical plug in a socket. Finally, if the client is connected to a server that is running an ETL process, the icon resembles a green electrical plug with a lightning sign superimposed on it. In addition, clicking on the icon when there is a connection to the server opens a text box that displays data related to the ETL process.

Table 9. DAC Server Monitor Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>DAC client cannot establish a connection to the DAC server.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>DAC client is connected to the server, and the server is idle.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>DAC client is connected to a server that is running an ETL process.</td>
</tr>
</tbody>
</table>
The DAC’s Navigation Tree

The navigation tree appears on the left side of the DAC window, as shown in Figure 8. The tree root nodes correspond to the tabs in the top pane of the DAC window. When a plus sign (+) appears before a node, you can expand the node to view the records belonging to the node. You can double-click a record in the tree to have it display in the top pane in a single-record mode (New, Delete, Copy Record, and Query commands are unavailable), and double-click the root node to return to the list mode.

The DAC’s Editable Lists

The top and bottom panes of the DAC window display records in a list format. Some of the columns in the list are editable, and others are read-only. The toolbar at the top of each pane allows you to perform various tasks associated with a selected record in the list. For a description of the toolbar commands, see “The DAC’s Top Pane Toolbar” on page 27.

A right-click menu is also accessible from the lists in both the top and bottom panes. For a description of these commands, see “The DAC’s Right-Click Menus” on page 28.

The list format allows you to do the following:

- Edit the data in place and save the record by either clicking another record in the list or clicking the Save button.
- Reorder the columns.
- Sort the data in the list by clicking on the column name.
Select predefined values from picklists.

For fields that refer to values from other entities, use the query functionality in pop-up dialog boxes.

Use Ctrl+C to copy an editable string to the clipboard (not available for read-only strings).

Ctrl+V to paste a string from the clipboard into a selected cell that supports a string data type.

**Using the DAC Query Functionality**

Querying is a way to locate one or more records that meet your specified criteria. Query functionality is available in every DAC screen. When you enter query mode, the Edit and Description child tabs in the bottom pane are not available.

This section includes the following topics:

- DAC Query Commands and Operators on page 35
- DAC Query Examples on page 36
- Common DAC Query Procedures on page 36
- Using Flat Views Querying on page 37

**DAC Query Commands and Operators**

Table 10 describes the query commands and operators you can use to define your query criteria.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Placed before a value, returns records containing a value equal to the query value.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Placed before a value, returns records containing a value less than the query value.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Placed before a value, returns records containing a value greater than the query value.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Placed before a value, returns records containing a value that is not equal to the query value.</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Placed before a value, returns records containing a value less than or equal to the query value.</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Placed before a value, returns records containing a value greater than or equal to the query value.</td>
</tr>
<tr>
<td>*</td>
<td>Wildcard that can be placed in the middle, or at the beginning or end of a text string.</td>
</tr>
<tr>
<td>!</td>
<td>Used for negation.</td>
</tr>
</tbody>
</table>
**Overview of the DAC Interface**  ■ Using the DAC Query Functionality

### DAC Query Examples

The following examples show different ways you can query on the Name column of the Tasks tab.

- **Extract** lists all tasks whose name starts with Extract.
- **Extract** lists all tasks whose name contains the word Extract.
- **!Extract** lists all tasks whose name does not start with the word Extract.
- **!null** lists all tasks whose name is not null.
- **Extract** or **Aggregate** lists all tasks whose name starts with Extract or Aggregate.
- **Load** and **Aggregate** lists all tasks whose name starts with Load and also contains the word Aggregate.
- "Extract for Wave Dimension" or "Load into Wave Dimension" lists tasks whose name is either Extract for Wave Dimension or Load into Wave Dimension.

**NOTE:** When using spaces within strings, you need to surround the string with quotes (" ").

### Common DAC Query Procedures

This section includes instructions for common query procedures.

#### To create and execute a query in the DAC

1. In the top or bottom pane of the DAC, click Query on the toolbar or in right-click menu.

   A blank row in a list appears.

2. Enter the query criteria in the appropriate fields.

---

Table 10. DAC Query Commands and Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>''</code></td>
<td>Surrounds a string that, unless modified by a wildcard, must be matched exactly.</td>
</tr>
<tr>
<td>\</td>
<td>Escape symbol is used when double quotes should not be processed as a special symbol. For example, <code>!(&quot;null text&quot;or(&quot;&quot;*))</code> is a value expression for a text field. The query returns values that do not end with a string <code>null text</code> and that are not surrounded by double quotes.</td>
</tr>
<tr>
<td>()</td>
<td>Surrounds the values and operators that will be processed first.</td>
</tr>
<tr>
<td>NULL</td>
<td>Returns records for which the query field is blank.</td>
</tr>
<tr>
<td>AND</td>
<td>Placed between values, returns only records for which all the given conditions are true. (Not case sensitive.)</td>
</tr>
<tr>
<td>OR</td>
<td>Placed between values, returns records for which at least one condition is true. (Not case sensitive.)</td>
</tr>
</tbody>
</table>
3  Click Run Query on the toolbar.
   The query is executed and the records appear.

To enter a query value in a date field
1  In the date field, click the calendar icon on the right side of the cell.
   The Date dialog box appears.
2  Enter the date and time for which you want to search, and select the appropriate query condition.

Using Flat Views Querying
You can use the Flat Views query feature to query for various objects, modify data, and do mass updates. This feature is available in the right-click menu in the Tables, Indices, and Tasks tabs of the Design view. The Flat Views right-click command is context-sensitive and allows you to query only on certain columns.

You can modify individual records in the query results window, or you can use the Update Records right-click command to update multiple records.

To update multiple records using the Flat Views query feature
1  In the DAC, right-click in the Tables, Tasks or Indices tab.
2  Select Flat Views, and then select a context-sensitive column on which you want to query.
3  In the query dialog box, enter search criteria, and click Go.
4  In the query results dialog box, right-click and select Update Records.
5  In the Update Record Set dialog box, select the column you want to update, and then click Set Value.
6  Enter a value for the column.
7  To update records that are referenced objects, select Update Referenced Records.
   If you select this check box, referenced objects as well as original and cloned objects will be updated. The referenced objects will become clones, and the ownership column for these records will be updated to reflect the new ownership.
   If you do not select this check box, only the columns in records that are original or cloned objects (objects owned by the source system container) will be modified.
8  Click OK.
9  Click Yes when asked if you want to proceed.
   An informational message tells you which records were updated.
10 Click OK to close the window.
About Object Ownership in the DAC

The source system container in which an object originates is the owner container. The tabs in the DAC Design view display the owner of the various repository objects. You can reuse an object among different source system containers by referencing the object. A reference works like a symbolic link or shortcut. You can use the referenced object just as you would an original object, but the object’s ownership remains unchanged.

For example, W_INVOICE_F is a fact table whose owner is the Siebel 7.8 source system container. You can reuse W_INVOICE_F in any other container by referencing it.

You can reference an object from its owner container, and you can also reference an object that has already been referenced by another source system container.

If you modify a referenced object, the modified object becomes a clone and the ownership changes to the source system container in which you performed the modification.

When you make changes to an original object that has been referenced by other containers, any updates to the original object are immediately reflected in the referenced object. If you delete the original object, all referenced objects are also deleted.

Changes to an original object’s child objects are not automatically reflected in the referenced object’s child objects. You need to use the right-click command Ownership > Push to References to push the changes to the referenced object’s child objects. And, conversely, you can import into a referenced object the changes made to an original object; this function is referred to as a re-reference.

For a description of the ownership functionality available in the Design view right-click menu, see “Design View Right-Click Menu Commands” on page 30.

Font Variations of Objects Displayed in the DAC

The different categories of objects are represented in the DAC with differing fonts.

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original object</td>
<td>(System dependent) Black by default, regular style.</td>
</tr>
<tr>
<td>Referenced object</td>
<td>Green color, italic style.</td>
</tr>
<tr>
<td>Clone</td>
<td>Blue color, regular style.</td>
</tr>
</tbody>
</table>

Object Behaviors To Consider

- Changes made to parent objects in the owner container are automatically pushed to the parent referenced objects.

- When you add child objects to a parent object, you have to push the changes to the referenced objects. For example, if you add a column to a table registered in the DAC, the new column is not automatically added to the references.
When you delete a referenced object, only the referenced object is deleted, not the original object.

If you delete an object from the owner container, the object is deleted and all references are deleted. This is referred to as a deep delete. For example, if you delete a table from the owner container, the table and columns are deleted.

If you delete a column from the owner table, the column is deleted in all the referenced objects.

If you delete child objects from the owner object, the referenced child objects are automatically deleted.
This chapter provides information about customizing, designing, executing, and monitoring ETL processes.

This section includes the following topics:

- Creating or Copying a Source System Container on page 41
- About Customizing the Data Warehouse on page 42
- Adding a New Table and Columns to the Data Warehouse on page 44
- Adding an Index to the Data Warehouse on page 46
- Importing New Data Warehouse Objects into the Informatica Repository on page 46
- Creating Informatica Mappings and Workflows on page 46
- Creating Tasks in the DAC for New or Modified Informatica Workflows on page 47
- Setting a Task Phase Dependency on page 48
- Creating a Task Group on page 49
- Setting Source System Parameters on page 49
- Setting Task Level Parameters on page 50
- Working with Configuration Tags on page 51
- Considerations in Designing a Subject Area on page 54
- Creating a Subject Area on page 56
- Building and Running an Execution Plan with the DAC on page 57
- Creating a Micro ETL Execution Plan on page 58
- Scheduling an Execution Plan on page 60
- About Refresh Dates on page 60
- Monitoring Execution Plan Processes on page 61

## Creating or Copying a Source System Container

The metadata for a source system is held in a container. You cannot change the metadata for preconfigured containers. If you want to customize the metadata in a preconfigured container, you must first make a copy of the container. The DAC keeps track of all customizations in the copied container, so that at any time you can find the newly created objects and modified objects, as well as the original objects.
You can also create a new, empty container if you want to build your own container with customized metadata.

**To create a new container or copy an existing container**

1. In the DAC’s menu bar, click File > New Source System Container.
2. Enter an ID and a name for the container.
   The ID and Name fields are alphanumeric. The Name can contain spaces but the ID cannot.
3. Select one of the following:
   - Create Empty New Source System Container
   - Create as a Copy of Source System Container
4. If you are creating an empty, new container, click OK.
5. If you are making a copy of an existing container, select the existing container from the drop-down list, and then click OK.

**About Customizing the Data Warehouse**

You can add tables, columns, and indices to the data warehouse, and you can modify these existing objects. Customizing the data warehouse in this way requires using the DAC and Informatica client tools. For more information about using Informatica client tools to customize the Oracle Business Analytics Warehouse, see the *Oracle Business Intelligence Applications Installation and Configuration Guide*. 
Figure 9 shows the major steps required for adding a new object to the data warehouse or modifying existing objects. As shown in Figure 9, you can begin the customization process by adding or modifying the new data warehouse object in the DAC and then using the DAC’s Data Warehouse Configurator to create or update the object in the data warehouse. Alternatively, you can add or modify the object directly in the data warehouse database and then use the DAC’s Import from Database command to add the new object in the DAC.

![Figure 9: Process Flow to Add New Object to Data Warehouse](image)
Adding a New Table and Columns to the Data Warehouse

As shown in Figure 9, there are two alternative process flows for adding a new object to the data warehouse. You can enter the table and column definitions in the DAC and then use the DAC’s Data Warehouse Configurator to create the table and columns in the data warehouse database; for this method, follow the procedure, “To add a new table and columns to the data warehouse using the DAC’s Data Warehouse Configurator” on page 44.

Alternatively, you can add the new table and column definitions directly in the data warehouse database and then use the DAC’s Import from Database command to add the new table and columns in the DAC; for this method, follow the procedure, “To add a new table and columns using the DAC’s Import command” on page 45.

To add a new table and columns to the data warehouse using the DAC’s Data Warehouse Configurator

1. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.

2. In the Menu bar, click Views > Design > Tables.

3. Create the new table.
   
   a. In the Tables tab, click New.
   
   b. In the Edit child tab, enter the appropriate information about the table, and click Save.
      
      For a description of the fields in this tab, see "About the DAC Tables Tab" on page 92.

4. Add the columns for the new table.
   
   a. In the Columns child tab, click New.
   
   b. Enter the appropriate column information for each column you want to add to the table, and click Save.
   
   c. Enter the appropriate foreign key table and column information.

   **NOTE:** For performance purposes, it is recommended that you do not enter more than 254 columns to a dimension or fact table.

5. Create the new tables and columns in the data warehouse database.
   
   a. Choose Tools > ETL Management > Configure.
   
   b. Select the appropriate Source and Target database platforms, and then click OK.
   
   c. In the Data Warehouse Configuration Wizard, select Create Data Warehouse Tables, and then click Next.
   
   d. Enter the required information, and then click Start.
      
      An informational message reports whether the process was successful. For information about the process, you can review the createwtables.log file in the OracleBI\DAC\log\config folder.
To add a new table and columns using the DAC’s Import command

1. Add the new table and column definitions into the data warehouse database.

2. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.

3. In the Menu bar, click Views > Design > Tables.

4. Import the new table definition.
   a. Right-click and select Import from Database > Import Database Tables.
   b. In the Import Tables dialog box, select DataWarehouse.
   c. Optionally, enter filter criteria to identify the table name you entered in Step 1.
      See “DAC Query Commands and Operators” on page 35 for available filter commands and operators.
   d. Click Read Tables.
   e. In the list of tables displayed, select the Import check box for the tables you want to import.
   f. Click Import Tables.
      An informational message indicates whether the process was successful.

5. Import the new column definitions.
   a. In the Tables tab, query for the table you imported in Step 4.
   b. With the table highlighted, right-click and select Import from Database > Import Database Columns.
   c. In the Importing Columns... dialog box, select Selected Record Only, and then click OK.
   d. In the Import Table Columns dialog box, click Read Columns.
      The Changes column displays a description of column changes, which are explained below:

<table>
<thead>
<tr>
<th>Change</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>The object was added to the database.</td>
<td>The column is in the database but not the DAC repository. Importing it will add the column to the DAC repository.</td>
</tr>
<tr>
<td>The object was added to the repository.</td>
<td>The column is in the DAC repository but not in the database. Importing it will delete it from the DAC repository.</td>
</tr>
<tr>
<td>The object was modified.</td>
<td>The column definition in the database doesn’t</td>
</tr>
</tbody>
</table>

   e. In the list of columns displayed, select the Import check box for the columns you want to import.
   f. Click Import Columns.
      An informational message indicates whether the process was successful.
Adding an Index to the Data Warehouse

Follow this procedure to add a new index to the data warehouse.

**To add a new index to the data warehouse**

1. Add the new index definition into the data warehouse database.
2. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.
3. In the Menu bar, click Views > Design > Tables.
4. Query for the table for which you want to import index definitions.
5. Right-click and select Import from Database > Import Indices.
6. Choose to import indices for a selected table or for all the records retrieved in your query, and click OK.
7. In the Import Indices dialog box, select DataWarehouse from the Data Sources drop-down list.
8. Click Read Indices.
   a. In the list of indices displayed, select the Import check box for the indices you want to import.
   b. Click Import Indices.
      An informational message indicates whether the process was successful.

Importing New Data Warehouse Objects into the Informatica Repository

This step requires using Informatica client tools to import new data warehouse objects into the Informatica repository. For instructions on this step of customizing the data warehouse, see *Oracle Business Intelligence Applications Installation and Configuration Guide*.

Creating Informatica Mappings and Workflows

This step requires using Informatica client tools to create new Informatica mappings and workflows for the data warehouse objects that you imported into the Informatica repository. For instructions on this step of customizing the data warehouse, see *Oracle Business Intelligence Applications Installation and Configuration Guide*.
Creating Tasks in the DAC for New or Modified Informatica Workflows

You need to perform this step for all new workflows you create in Informatica and for all workflows that you modify.

1. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.

2. In the DAC, create custom logical and physical task folders for the custom folder you created in the Informatica repository.
   a. In the DAC, navigate to Tools > Seed Data > Task Folders.
   b. To create a custom logical folder, click New.
   c. In the Name field, enter a name for the custom logical folder, for example, Custom Logical.
   d. In the Type field, select Logical.
   e. To create a custom physical folder, click New.
   f. In the Name field, enter a name for the custom physical folder, for example, Custom Physical.
   g. In the Type field, select Physical.

3. Register the folders you created in Step 2 in the Source System Folders tab.
   a. Navigate to Design > Source System Folders.
   b. Click New.
   c. In the Edit child tab, enter the name of the custom logical folder in the Logical Folder field.
   d. Enter the name of the custom physical folder in the Physical Folder field, and click Save.

4. Create new tasks for the workflows.
   a. Navigate to Design > Tasks, and click New in the top pane toolbar.
   b. In the Edit child tab, enter the workflow name as it appears in Informatica Workflow Manager.
   c. Right-click and select Synchronize Tasks.
   d. Select Selected Record Only, and click OK. Click OK in the informational message box.
      This command synchronizes the source and target table information between the DAC and Informatica.
   e. In the Tasks tab, enter the remaining information required for the task.
      For a description of the fields in this tab, see “About the DAC Tasks Tab” on page 97.

The new table is now ready to be associated with a subject area. For information about creating a subject area, see “Creating a Subject Area” on page 56.
Setting a Task Phase Dependency

A task phase dependency allows you to change the order in which tasks are executed. When you set a task phase dependency, you work with three properties:

- **Action.** The action to be taken in relation to the phase dependency. Possible values are the following:
  - **Wait.** Allows you to set a task to wait for other tasks of a specified phase to be completed before it runs.
  - **Block.** Allows you to block all tasks of a specified phase from being executed until the specified task has been executed.

- **Grain.** Applicable only for blocks. Allows you to specify whether the action you choose affects all tasks of a specified phase or related tasks. (You can view a task’s related tasks by navigating to Execution Plans > All Dependencies and viewing the specified task’s predecessor tasks.)
  Possible values are:
  - **All.** Indicates the action will affect all tasks.
  - **Related.** Indicates the action will affect only related tasks. You can view a task’s related tasks by navigating to Execution Plans > All Dependencies and viewing the specified task’s predecessor tasks.

- **Phase.** The phase that applies to the action you choose.

**To set a task phase dependency**

1. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.
2. In the Menu bar, click Views > Design > Tasks.
3. Query for the task for which you want to add a phase dependency, and make sure it is highlighted.
4. Click the Phase Dependency child tab.
5. Click Add/Remove.
6. In the Choose Phases dialog box, select a phase and click Add.
7. Click OK in the message box that states the phase was added.
8. Select an Action and a Grain, click OK.
   The task phase dependency appears in the Phase Dependency child tab.
9. Reassemble the appropriate subject area.
   a. In the Subject Areas tab, query for the appropriate subject area.
   b. Click Assemble.
10. Rebuild the execution plan.
Creating a Task Group

The DAC automatically organizes tasks into a dependency structure based on dependency rules. For information about the DAC’s dependency rules, see “How the DAC Determines the Order of Task Execution within an Execution Plan” on page 55. The DAC assigns priority randomly to tasks that have the same properties. You can use the Task Group feature to group such tasks that share the same properties and enforce a priority of your choosing.

This feature can be useful for the following: truncation and restartability purposes; when more than one task with similar properties writes to the same table; and when there is a circular read/write relationship between tables; for example, task 1 reads from table A and writes to table B, and task 2 reads from table B and writes to table A.

To create a task group
1. In the DAC, select the appropriate source system container from the drop-down list in the toolbar.
2. In the Menu bar, click Views > Design > Task Groups.
3. Create a new task group.
   a. Click New in the top pane toolbar.
   b. In the Edit child tab, enter a name and select the appropriate properties.
4. Click the Child Tasks child tab, and click Add/Remove in the toolbar.
5. In the left-hand window of the Choose Child Tasks dialog box, query for the tasks you want to add to the task group.
6. Select the tasks, and click Add.
7. In the right-hand window, enter an execution order.
8. Click Save, and then click OK to close the window.

Setting Source System Parameters

Source system parameters are specific to source system containers. You can set static or runtime parameters in the Source System Parameters tab of the Design view.

To set a source system parameter
1. In the DAC, select the appropriate source system container from the drop-down list in the toolbar.
2 In the Menu bar, click Views > Design > Source System Parameters.
3 Click New in the top pane toolbar.
4 In the Edit child tab, enter a name for the parameter.
5 Select one of the following data types:
   ▪ Text
   ▪ Timestamp
   ▪ SQL
6 Click in the Value field to open the Enter Parameter Value dialog box.
7 If you selected the Text data type:
   a Select Static or Runtime.
   b For a static parameter, enter the parameter information in the text box, and click OK.
   c For a runtime parameter, select a variable, and click OK.
8 If you selected the Timestamp data type:
   a Select Static or Runtime.
   b Choose a function from the Function drop-down list.
      ❏ If you select Custom Format, enter a format in the Format field.
      ❏ If you select SQL Syntax, select a database connection in the Connection drop-down list.
   c If you selected Static, click in the Date field, and enter a date and time.
   d If you selected Runtime, select a variable from the Variable drop-down list.
9 If you selected the SQL data type:
   a Select a logical data source.
   b Enter the SQL statement in the text box, and click OK.
10 Click Save in the top pane toolbar or in the Edit child tab.

Setting Task Level Parameters

In addition to source system parameters, you can set a parameter at the task level. Task level parameters take precedence over the source system parameters.

To set a parameter at the task level
■ Navigate to Design view > Tasks tab > Parameters child tab, and then follow the instructions for “Setting Source System Parameters” on page 49.
Working with Configuration Tags

A configuration tag is an object that controls the inclusion of tasks in subject areas. When a task is tagged, it is not eligible to be included in the collection of tasks for any subject area, unless the tag is part of the subject area definition “Include Task” property.

A configuration tag can function in one of the following ways:

- **Remove tasks from all subject areas**
  
  If you assign a task to a configuration tag, the task will not be eligible to participate in any subject area. For instructions, see “To remove tasks from all subject areas” on page 51.

- **Reassign autogenerated tasks to a specific subject area**
  
  For autogenerated tasks that were removed from participating in a subject area, you can set up the configuration tag to reassign a task to participate in specific subject areas. You do this by associating the configuration tag with the desired subject area. This method only applies to tasks that are autogenerated tasks of a subject area. For instructions, see “To reassign autogenerated tasks to a subject area” on page 52.

- **Add non-autogenerated tasks to a subject area**
  
  You can set up a configuration tag to add non-autogenerated tasks to a subject area. The non-autogenerated tasks will participate in the subject area along with the subject area’s autogenerated tasks. For instructions, see “To add non-autogenerated tasks to a subject area” on page 52.

Indicates whether configuration tag tasks are the only tasks associated with this subject area that will participate in the ETL process. If this check box is selected, only the tasks associated with the configuration tag will be chosen by the DAC when the subject area is assembled.

- **Assign only configuration tag tasks to a subject area (excludes the subject area’s autogenerated tasks)**
  
  You can also set up a configuration tag so that only tasks that were assigned to the configuration tag participate in a specific subject area. In this case, the subject area’s autogenerated tasks do not participate. For instructions, see

---

**To remove tasks from all subject areas**

1. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.
2. In the Menu bar, click Views > Design > Configuration Tags.
3. Create a new configuration tag.
   a. Click New in the top pane toolbar.
   b. In the Edit child tab, enter a name.
   c. Make sure the Include Tasks check box is not selected.
   d. Click Save.
4. Add tasks to the configuration tag.
With the new configuration tag highlighted in the top pane, click the Tasks child tab.

b In the bottom pane toolbar, click Add/Remove.

c In the Tasks dialog box, query for the tasks you want to add to the configuration tag.

d Highlight the tasks, and then click Add.

The tasks appear in the right-hand window.

e Click Save, and then click OK to close the window.

These tasks will not be eligible to participate in any subject area.

To reassign autogenerated tasks to a subject area

1 In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.

2 In the Menu bar, click Views > Design > Configuration Tags.

3 Query for the configuration tag that contains the tasks you want to reassign to a subject area.

4 Verify the configuration tag contains the appropriate tasks by clicking the Tasks child tab and reviewing the list of tasks associated with this configuration tag.

NOTE: Only a subject area’s autogenerated tasks will be reassigned. If non-autogenerated tasks appear in the list, the DAC will ignore them.

5 Associate the configuration tag with the subject areas to which you want to reassign the tasks.

a With the configuration tag highlighted in the top pane, click the Subject Areas child tab.

b Click Add/Remove in the bottom pane toolbar.

c In the Subject Areas dialog box, query for one or more subject areas to which you want to reassign the task or tasks.

d Highlight the appropriate subject areas, and click Add.

e Click Save, and then click OK to close the window.

6 Reassemble the subject area.

a In the Subject Area tab, query for all the subject areas you added to the configuration tag.

b Highlight the subject areas, and click Reassemble.

To add non-autogenerated tasks to a subject area

1 In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.

2 In the Menu bar, click Views > Design > Configuration Tags.

3 Create a new configuration tag.

a Click New in the top pane toolbar.

b In the Edit child tab, enter a name.
c  Select the Include Tasks check box.
d  Click Save.

4 Add the non-autogenerated tasks to the configuration tag.
   a  With the new configuration tag highlighted in the top pane, click the Tasks child tab.
   b  In the bottom pane toolbar, click Add/Remove.
   c  In the Tasks dialog box, query for the extraneous tasks you want to add to the configuration tag.
   d  Highlight the tasks, and then click Add.
   e  Click Save, and then click OK to close the window.

5 Associate the configuration tag with the subject areas to which you want to add the non-autogenerated tasks.
   a  With the configuration tag highlighted in the top pane, click the Subject Areas child tab.
   b  Click Add/Remove in the bottom pane toolbar.
   c  In the Subject Areas dialog box, query for one or more subject areas to which you want to add the non-autogenerated tasks.
   d  Highlight the appropriate subject areas, and click Add.
   e  Click Save, and then click OK to close the window.

6 Reassemble the subject area.
   a  In the Subject Area tab, query for all the subjects areas you added to the configuration tag.
   b  Highlight the subject areas, and click Reassemble.

To assign only configuration tag tasks to a subject area (excludes the subject area’s autogenerated tasks)

1  In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.

2  In the Menu bar, click Views > Design > Subject Areas.

3  Query for the subject area to which you want to add configuration tag tasks.
   NOTE: The autogenerated tasks for this subject area will be excluded.

4  Select the Configuration Tag Tasks Only check box, and click Save.

5  Create a configuration tag.
   a  Navigate to the Configuration Tags tab.
   b  Click New in the top pane toolbar.
   c  In the Edit child tab, enter a name.
   d  Select the Include Tasks check box.
   e  Click Save.

6  Add the tasks to the configuration tag.
a With the new configuration tag highlighted in the top pane, click the Tasks child tab.
b In the bottom pane toolbar, click Edit.
c In the Tasks dialog box, query for the tasks you want to add to the configuration tag.
d Highlight the tasks, and then click Add.
e Click Save, and then click OK to close the window.

7 Associate the configuration tag with the subject area.
   a With the configuration tag highlighted in the top pane, click the Subject Areas child tab.
   b Click Add/Remove in the bottom pane toolbar.
   c In the Subject Areas dialog box, query for the appropriate subject area.
   d Highlight the subject area, and click Add.
   e Click Save, and then click OK to close the window.

8 Reassemble the subject area.
   a In the Subject Area tab, query for all the subjects areas you added to the configuration tag.
   b Highlight the subject areas, and click Reassemble.

Considerations in Designing a Subject Area

Oracle Business Intelligence Applications provides preconfigured subject areas. You can change these preconfigured subject areas or create new subject areas to correspond to your particular business processes.

NOTE: To change a preconfigured subject area or to create a new subject area, you must first make a copy of an existing source system container or create a new container. For instructions, see “Creating or Copying a Source System Container” on page 41.

Designing a Subject Area

In designing a subject area, you should consider the following questions:

- **Tables.** Which tables need to be populated for the data warehouse? From which tables does your organization source data? What tables will create the star schemas.

- **Subject areas.** Do the subject areas cover all the relevant tables?

- **Tasks.** Are the tasks that load this table defined?

- **Indices.** Do the target tables have the correct indices defined?

How the DAC Determines Tasks Required for Subject Areas

A subject area is a collection of tasks. When a subject area is defined, the DAC uses the following logic to assemble the collection of tasks:
1. Initial selection of tables.
   Find all the fact tables that belong to the subject areas.

2. Recursive selection of related tables.
   Recursively find all the tables directly related through foreign keys and all other logically related tables.

3. Initial selection of tasks.
   Find all the tasks that load into the tables selected above, that is, tasks whose target tables are one of the tables identified above.

4. Recursive selection of all tasks.
   Depending on the source and target table relationships, recursively figure out the prerequisite tasks.

**How the DAC Determines the Order of Task Execution within an Execution Plan**

An execution plan is a collection of subject areas and a unique collection of tasks. A task can have prerequisite tasks that need to be executed before its own execution. The DAC determines the order of tasks based on the following considerations:

- **A task’s source and target table**
  The DAC server first looks at a task’s source and target table. For example, suppose table A is populated by task T1 by reading from table B, and table B is populated by task T2 by reading from table C. The DAC server would determine task T2 should be executed before T1.
  The DAC server next considers the following:

- **Task phase**
  An ETL process typically goes through several phases. An example of a typical order in which phases are executed is as follows:
  a. Extract Dimension
  b. Extract Fact
  c. Load Dimension
  d. Load Fact and Load Hierarchy (executed in parallel)
  e. Load Aggregate tables
  f. Update Dimensions

- **A table’s Truncate Always properties**
  The order of execution based on Truncate Always properties is as follows:
  a. Insert
  b. Upsert
  c. Physical data source
The DAC randomly organizes tasks that are the same in all properties. If some tasks need to be executed in a particular order, the DAC allows you to create a task group in which you can specify an execution order.

Creating a Subject Area

When you create a new subject area, you assign one or more fact tables to the subject area. The DAC then determines which dimension and other related tables are required as well as the tasks and their order of execution.

To create a new subject area

1. In the DAC, select the appropriate source system container from the drop-down list in the toolbar.
2. In the Menu bar, click Views > Design > Subject Areas.
3. In the top pane toolbar, click New.
4. In the Edit child tab, enter a name for the subject area, and click Save.
5. Make sure the new subject area name is highlighted in the top pane, and click the Tables child tab.
6. Click Add/Remove in the child tab toolbar.
   - The Choose Tables dialog box opens. The left-hand window lists all the tables held in the selected container.
7. Query for one or more fact tables.
8. Select the fact table (use Shift+click to select more than one table), and click Add.
   - The tables are added to the right-hand window, which represents the subject area.
9. Click OK to close the Choose Tables dialog box.
10. In the top pane toolbar, click Assemble.
11. In the Assembling... dialog box, select Selected Record Only.
   - If you select the option All Records in the List, the DAC will reassemble all the subject areas listed in the top pane.

   The DAC assembles the selected subject area by determining what dimensions and other related tables are required and what tasks are needed to load these tables.

   You will receive an informational message when the assemble process is completed.
Building and Running an Execution Plan with the DAC

Execution plans are subject areas that are used to execute ETL processes. Before you attempt to run an execution plan, make sure you have completed the following:

- Set database connections to the transactional and data warehouse databases
- Registered the Informatica servers and repository server

To build and run an execution plan

1. Navigate to Execute > Execution Plans.
2. Create a new execution plan.
   a. In the top pane toolbar, click New.
   b. In the Edit child tab, enter a name for the execution plan and other appropriate information. For a description of the fields in this tab, see “About the DAC Execution Plans Tab” on page 115.
   c. Click Save.
3. Associate one or more subject areas with the execution plan.
   a. Click the Subject Areas child tab.
   b. Click Add/Remove in the bottom pane toolbar.
   c. In the Choose Subject Areas dialog box, select the appropriate source system container.
   d. Query for the subject area you want to associate with the execution plan.
   e. Select the subject area and click Add.
      You can associate multiple subject areas with an execution plan, but all the subject areas must be from the same source system container.
   f. Click OK to close the window.
4. Generate the runtime parameters.
   a. Click the Parameters child tab.
5. Click Generate in the bottom pane toolbar.
6. For each Datasource type, enter the appropriate name in the Value field.

In the top pane of the Execution Plans tab, make sure the new execution plan is highlighted, and click Build.

The DAC builds the execution plan.

6. To run the execution plan, select the execution plan in the top pane, and click Run Now.

Once the ETL process starts running you can monitor its progress in the Current Run tab.

For information about how refresh dates are tracked, see “About Refresh Dates” on page 60.

To schedule an execution plan, see “Scheduling an Execution Plan” on page 60.

Creating a Micro ETL Execution Plan

Micro ETL execution plans are ETL processes that you schedule at very frequent intervals, such as hourly or half-hourly. They usually handle small subject areas or subsets of larger subject areas. The DAC tracks refresh dates for tables in micro ETL execution plans separately from other execution plans and uses these refresh dates in the change capture process.

After a micro ETL execution plan runs, the DAC populates refresh date values in the Refresh Dates child tab of the Execution Plans tab. If a subject area is used in a regular execution plan (an execution plan with the Keep Separate Refresh Dates option not selected) as well as a micro ETL execution plan, the DAC maintains refresh dates for the tables in the regular execution plan in the Refresh Dates child tab of the Physical Data Sources tab (Setup view).

In cases of a subject area being used in both a regular and micro ETL execution plan and the micro ETL execution plan is suspended for a few days but the regular execution plan runs nightly, the DAC automatically detects the last refresh date for the tables common to both execution plans and intelligently extracts only the most recent records for the micro ETL execution plan.

**CAUTION:** Micro ETL processes can cause issues with data inconsistencies, data availability, and additional load on the transactional database. Therefore, you should consider the following factors before implementing a micro ETL process:

- For related star schemas, if one schema is omitted from a micro ETL execution plan, the cross-star reports may be inaccurate. For example, if the Person fact table is refreshed more frequently than the Revenue fact table, a report that spans the Person and Revenue dimensional schemas may produce inconsistent results.

- If you omit dimension tables from a micro ETL execution plan, the foreign keys for the fact tables will point to Unspecified rows for the new dimension records. The foreign key references will be resolved when the Complete ETL execution plan is run, but users of the reports should be aware of such inconsistencies.

- If you do not include aggregate tables in micro ETL execution plans, the reports that use data from these tables will be inconsistent with the reports that use data from the detailed fact tables. However, if aggregate tables are included in the micro ETL execution plan, the aggregate calculations are performed for each ETL process, which will take a constant amount of time and may be inefficient to perform at such frequent intervals.
Hierarchy tables are rebuilt during every ETL execution plan by querying the base dimension tables. This operation takes a constant amount of time. If the base tables are big, this operation may take a long time and may be inefficient if the micro ETL execution plan runs several times a day. However, if you avoid populating the hierarchy tables during micro ETL processes, data inconsistencies will occur.

With micro ETL execution plans, caching will occur more frequently, which may have performance implications.

Micro ETL execution plans will put more load on the transactional database because of the frequent extracts.

**To create a micro ETL execution plan**

1. In the DAC toolbar, select the appropriate source system container from the drop-down list in the toolbar.
2. In the Menu bar, click Views > Design > Subject Areas.
3. In the Subject Areas tab, assemble a small subject area.
4. In the Tasks child tab, inactivate all tasks that are not required for the execution plan.
5. Create a new execution plan.
   a. Navigate to Execute > Execution Plans.
   b. Enter a name for the execution plan
   c. Select the Keep Separate Refresh Dates check box.
   d. Click Save.
6. Associate one or more subject areas with the execution plan.
   a. Click the Subject Areas child tab.
   b. Click Add/Remove in the bottom pane toolbar.
   c. In the Choose Subject Areas dialog box, select the appropriate source system container.
   d. Query for the subject area you want to associate with the execution plan.
   e. Select the subject area and click Add.
      You can associate multiple subject areas with an execution plan, but all the subject areas must be from the same source system container.
   f. Click OK to close the window.
7. Generate the runtime parameters.
   a. Click the Parameters child tab.
   b. Click Generate in the bottom pane toolbar.
   c. For each Datasource type, enter the appropriate name in the Value field.
8 In the top pane of the Execution Plans tab, make sure the new execution plan is highlighted, and click Build.
   The DAC builds the execution plan.

9 Navigate to the Ordered Tasks child tab and verify the sequence of tasks.
   The execution plan is now ready to run as a micro ETL execution plan.

10 Create a schedule for the micro ETL execution plan. For instructions, see "Scheduling an Execution Plan" on page 60.

Scheduling an Execution Plan
Use this procedure to schedule an execution plan in the DAC.

To schedule an execution plan
1 In the DAC, navigate to the Scheduler tab.
   The current list of schedules appears in the top pane.

2 Click New in the top pane toolbar.
   The Edit tab in the bottom pane becomes active.

3 Enter a name for the schedule.

4 Select an execution plan.

5 If you want the schedule to run once, select the Run Only Once check box, and then select a start and end date and time.

6 To create a periodic schedule, select a recurrence pattern, and enter the appropriate date and time parameters.

7 Click Save.

About Refresh Dates
Refresh dates refer to the date of the last ETL process (the last time data was extracted from tables in a given database or loaded into tables in a given database). The DAC uses the refresh dates to determine whether to run the incremental load commands or to run full load commands and whether to truncate the target tables.

Refresh dates are tracked only for tables that are either a primary source or a primary target on tasks in a completed run of an execution plan. The DAC runs the full load command for tasks on which a table is a primary source or target if the refresh date against the table is null. When there are multiple primary sources, the earliest of the refresh dates will trigger a full load or an incremental load. If any one of the primary source tables has no refresh date, then the DAC will run the full load command.
Table 12 shows the possible scenarios regarding refresh dates.

Table 12. Refresh Date Scenarios

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Table Type (in Tasks child tabs)</th>
<th>Refresh Date</th>
<th>Command DAC Will Use</th>
<th>Truncate Target Table?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Primary Source</td>
<td>Null</td>
<td>Full Load</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Primary Target</td>
<td>Null</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Primary Source</td>
<td>Null</td>
<td>Full Load</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Primary Target</td>
<td>Not Null</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Primary Source</td>
<td>Not Null</td>
<td>Full Load</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Primary Target</td>
<td>Null</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Primary Source</td>
<td>Not Null</td>
<td>Incremental Load</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Primary Target</td>
<td>Not Null</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Scenario 2.** When two or more source tables load into the same target table as separate tasks, the source table in the second task may have refresh date as null while the target may have a refresh date.
- **Scenario 3.** When a source loads into more than one target table in separate tasks, the refresh date may be null for the second target table while the source table may have refresh dates.

**Monitoring Execution Plan Processes**

The Current Run tab in the Execute view provides predefined reports that allow you to monitor execution plan processes in order to isolate bottlenecks and enhance performance.

**To monitor an execution plan process**

1. In the DAC, navigate to the Current Run tab.
2. Right-click and select Get Run Information.
   
The following options are available:
   - Get log file
   - Analyze run
   - Get chart
   - Get phase chart
   - Get graph
Common Tasks Performed in the DAC

This chapter contains the following topics:

- Importing DAC Metadata on page 63
- Exporting DAC Metadata on page 64
- Distributing DAC Metadata on page 65
- Running the DAC Server Automatically on page 65
- Command Line Access to the DAC Server on page 66
- DAC Repository Command Line Options on page 70
- Replacing an Informatica Workflow with a Custom SQL File on page 72
- Determining the Number of Transactional and Data Warehouse Database Connections on page 75
- Running Two DAC Servers on the Same Machine on page 75
- Customizing Index and Analyze Table Syntaxes on page 76
- Using SQL Files as an Execution Type in the DAC on page 77
- Overview of Change Capture Process (Siebel Sources Only) on page 78
- Using the Change Capture Filter on page 84
- Tracking Deleted Records on page 84
- Handling ETL Failures with the DAC on page 86

Importing DAC Metadata

The DAC’s Import/Export feature allows you to import or export source system-specific DAC metadata into or out of the DAC repository. You can use this feature to migrate DAC metadata from one environment to another, such as from a development environment to test or production environments.

To import DAC metadata

1. In the DAC menu bar, select Tools > DAC Repository Management > Import.
2. Select the directory from which you want to import DAC metadata, or accept the default directory.
3. Select the appropriate source system containers.
4. Select the appropriate categories of metadata you want to import:
Exporting DAC Metadata

The DAC's Import/Export feature allows you to import or export source system-specific DAC metadata into or out of the DAC repository. You can use this feature to migrate DAC metadata from one environment to another, such as from a development environment to test or production environments.

**To export DAC metadata**

1. In the DAC menu bar, select Tools > DAC Repository Management > Export.
2. Select the directory to which you want to export DAC metadata, or accept the default directory.
3. Select the appropriate source system containers.
4. Select the appropriate categories of metadata you want to export:
   - **Logical.** Exports all information contained in the Design view and database connection information.
   - **System.** Exports all information contained in the Setup view, except passwords for servers and database connections.
   - **Run Time.** Exports information about ETL runs (contained in the Execute view).
5. Click OK.
6. Verify the export process by reviewing the log file \OracleBI\DAC\log\export.log.
Distributing DAC Metadata

Typically, you may have multiple environments, such as development, QA, production, and so on. When you make changes to the development environment, you test it, and then deliver it, exporting the whole environment and distributing it to the other environments. The data is exported as XML files, which are stored in the DAC\export directory on the client machine where the export is done.

To apply changes from the development environment to any other, you copy all of the XML files into the DAC\export folder and then import the data. To export the DAC metadata, follow the instructions in the procedure, “Exporting DAC Metadata” on page 64. To import the DAC metadata, follow the instructions in the procedure, “Importing DAC Metadata” on page 63.

Running the DAC Server Automatically

Follow this procedure to set up the DAC server to be run automatically when your machine reboots.

To set up the DAC server to run automatically upon rebooting the machine
1. Navigate to Programs > Accessories > System Tools > Scheduled Tasks.
2. Double-click Add Scheduled Task.
3. In the Scheduled Task Wizard, browse to the startserver.bat file, and click Open.
4. Select the option “When my computer starts,” and click Next.
5. Enter the domain user account to start the DAC server and a password, and click Finish.
   The startserver task appears in the Scheduled Task window.
6. Right-click the task and select Properties.
7. In the Settings tab, remove the check from the “Stop the task if it runs for 72 hours” check box.

To start the DAC server as a scheduled task
1. Navigate to Programs > Accessories > System Tools > Scheduled Tasks.
2. Right-click startserver, and then click Run.

To stop the DAC server as a scheduled task
1. Navigate to Programs > Accessories > System Tools > Scheduled Tasks.
2. Right-click startserver, and then click End Task.

To check if the DAC server is running
1. Navigate to Programs > Accessories > System Tools > Scheduled Tasks.
2. Select the startserver task.
3. In the Windows menu bar, select View > Details.
Command Line Access to the DAC Server

This section covers accessing the DAC server through a command line. It includes the following topics:

- Setting Up Command Line Access to the DAC Server on page 67
- Using the Command Line to Access the DAC Server on page 68

You can access the DAC server through a command line to start and stop execution plans and to get status information for servers, databases, and execution plans. This feature allows you to access the DAC server using third-party administration or management tools, without using the DAC client.

Command Line Operations

The command line feature allows you to start an execution plan and stop the operation of a running execution plan.

Starting an Execution Plan

When the DAC server receives a request to start an execution plan, it performs a series of checks to verify that the execution plan can be started. It first checks that an execution plan with the requested name exists and that the execution plan is active. Next, it checks the status of the execution plan that last ran. If an execution plan is still running and the DAC server receives a request to start another execution plan, the request will be rejected. If an execution plan failed, a request to run the same execution plan again will be executed; however, a request to run a different execution plan will be rejected. If the execution plan that last ran completed successfully, a request to run a new execution plan will be executed.

When the DAC server receives a request to start an execution plan, it will issue a warning if any of the following conditions are true. (A warning is for informational purposes and does not mean the execution plan will not start.)

- The Generic task concurrency limit (set in the system properties) is not a positive number.
- There are no active Informatica servers in the server list.
- One or more Informatica servers do not have the passwords defined.
- One or more Informatica servers do not have a maximum number of sessions properly set.
- One or more data sources do not have the passwords defined.
- One or more data sources do not have a maximum number of connections properly set.
- One or more data sources do not have a number defined (set in Physical Data Sources tab).

Stopping the Operation of a Running Execution Plan

When the DAC server receives a request to stop the operation of a running execution plan, the request will fail in the following cases:

- The name of the execution plan that is running is different from the name in the request.
- There is no execution plan currently running.
Command Line Status Monitoring Queries
The command line feature allows you to get the following status information:

- Summary of the requested execution plan. If there are multiple instances of the same execution plan, a summary of the instance that last ran is returned. Below is an example of the information contained in the summary.

(c) 2003 Siebel Systems, Inc.

Siebel DAC Server comprising the etl execution-management, scheduler, logger, and network server.

ETL details for the last run:

ETL Process Id : 255
ETL Name : Complete ETL
Run Name : DRY RUN OF Complete ETL: ETL Run - 2004-06-17 18:30:13.201
DAC Server : (aqamarD510)
DAC Port : 3141
Status: Stopped
Log File Name: Complete_ETL.255.log
Database Connection(s) Used :
  OLTP jdbc:microsoft:sqlserver://vranganaw8:1433;DatabaseName=OLTP
  Data Warehouse jdbc:microsoft:sqlserver://vranganaw8:1433;DatabaseName=olap
Informatica Server(s) Used :
  InformaticaServer4-vranganaw8:(4)
  InformaticaServer2-vranganaw8:(2)
  InformaticaServer3-vranganaw8:(3)
  InformaticaServer1-vranganaw8:(10)

Start Time: 2004-06-17 19:00:06.885
Message: ETL was interrupted
Actual Start Time: 2004-06-17 18:30:13.357
End Time: 2004-06-17 19:05:56.781
Total Time Taken: 35 Minutes
Start Time For This Run: 2004-06-17 19:00:06.885
Total Time Taken For This Run: 5 Minutes

Total steps: 212
Running steps: 0
Complete steps: 142
Failed/Stopped steps: 70

- Summary of connection status to all active databases and Informatica servers.

Setting Up Command Line Access to the DAC Server
Follow this procedure to set up the command line functionality.
**Common Tasks Performed in the DAC**  
**Command Line Access to the DAC Server**

**To set up command line access to the DAC server**

1. Make sure you have installed the supported version of the Java SDK.

2. Copy the following files from the OracleBI\DAC directory to a local directory:
   - DAWSystem.jar
   - dac.properties
   - dacCmdLine.bat

3. In the dacCmdLine.bat file, edit the JAVA_HOME variable to point to the directory where the Java SDK is installed.
   Make sure there are no spaces in the path reference.

4. Edit the DAC_HOME variable to point to the directory where DAC-REMOTE is installed.

5. In the dac.properties file, edit the following parameter values.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServerHost=</td>
<td>Host name of the DAC server.</td>
</tr>
<tr>
<td>ServerPort=</td>
<td>Port of the DAC server. The default is 3141.</td>
</tr>
<tr>
<td>RepositoryStampVal=</td>
<td>Repository stamp that appears in the DAC client Login Details screen.</td>
</tr>
<tr>
<td></td>
<td>To find this value, in the DAC client navigate to Help &gt; Login Details.</td>
</tr>
</tbody>
</table>

Your dac.properties file should look similar to the following:
```
ServerHost=vранганав8
ServerPort=3141
RepositoryStampVal=851E0677D5E1F6335242B49FC6CCd6519
```

**Using the Command Line to Access the DAC Server**

Follow this procedure to use the command line to access the DAC server.

**To use the command line to access the DAC server**

- At the command prompt, enter the following:
**Command Line Access to the DAC Server**

`dacCmdLine <method name> <optional execution plan name>`

where `method name` is one of the following:

<table>
<thead>
<tr>
<th>Method Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>StartETL</td>
<td>Starts an execution plan. You must specify an execution plan name.</td>
</tr>
<tr>
<td>StopETL</td>
<td>Stops the operation of an execution plan. You must specify an execution plan name.</td>
</tr>
<tr>
<td>ETLStatus</td>
<td>If you do not specify an execution plan name, the status of the execution plan that last ran is returned. If you Specify an execution plan name, the status of the specified execution plan is returned.</td>
</tr>
<tr>
<td>DatabaseStatus</td>
<td>Verifies whether the DAC server can connect to all active database connections. You do not need to specify an execution plan name.</td>
</tr>
<tr>
<td>InformaticaStatus</td>
<td>Verifies whether the DAC server is able to ping all active Informatica servers.</td>
</tr>
</tbody>
</table>

**NOTE:** The method names are case insensitive. Execution plan names are case sensitive. Also, if the execution plan name contains spaces, place beginning and ending double quotes around the name.

For example:

<table>
<thead>
<tr>
<th>Command Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>dacCmdLine EtlStatus</code></td>
<td>Returns the status of the execution plan that last ran.</td>
</tr>
<tr>
<td><code>dacCmdLine EtlStatus Forecast</code></td>
<td>Returns the status of the last instance of the Forecast execution plan.</td>
</tr>
<tr>
<td><code>dacCmdLine StopEtl Forecast</code></td>
<td>If the execution plan currently running is Forecast, the operation will be terminated. Otherwise, the request is ignored.</td>
</tr>
<tr>
<td><code>dacCmdLine databaseStatus</code></td>
<td>Returns the health status of all the database connections as defined in the DAC repository from the DAC server.</td>
</tr>
<tr>
<td><code>dacCmdLine InformaticaStatus</code></td>
<td>Returns the health status of all the Informatica server connections as defined in the DAC repository from the DAC server.</td>
</tr>
</tbody>
</table>
DAC Repository Command Line Options

This section describes the DAC repository command line parameters that are exposed by the AutomationUtils.bat file, which is located in the OracleBI\DAC folder.

Import DAC Metadata by Application
The IMPORT option imports DAC metadata into the DAC repository for specified source system containers. The import process truncates all imported tables. You cannot perform an incremental import with this command.

Syntax:

IMPORT <folderName> <contName1> <contName2> ...

where:

  folderName          Full path to the root of the import file structure.
  contName            (Optional) Name of the source system container for which you want to import DAC metadata. If no container is named, all containers that are found in the file structure will be imported.

Export DAC Metadata by Application
The EXPORT option exports DAC metadata from the DAC repository for specified source system containers.

Syntax:

EXPORT <folderName> <contName1> <contName2> ...

where:

  folderName          Full path to the root of the export file structure.
  contName            (Optional) Name of the source system container for which you want to export DAC metadata. If no container is named, all containers that are found in the file structure will be exported.

Import DAC Metadata by Categories
The IMPORTCATEGORY option imports DAC metadata into the DAC repository based on the Logical, Run Time, or System categories. The import process truncates all imported tables. You cannot perform an incremental import with this command.

Syntax:

IMPORTCATEGORY <folderName> <logicalFlag> <runtimeFlag> <systemFlag>

where:

  folderName          Full path to the root of the import file structure.
Common Tasks Performed in the DAC  ■ DAC Repository Command Line Options

EXPORTCATEGORY <folderName> <logicalFlag> <runtimeFlag> <systemFlag>

where:

folderName  Full path to the root of the import file structure.
logicalFlag  If the value of this parameter is true, all data categorized as logical is exported (information contained in the DAC Design view). Otherwise, this parameter is ignored.
runtimeFlag  If the value of this parameter is true, all data categorized as run time is exported (information contained in the DAC Execute view). Otherwise, this parameter is ignored.
systemFlag  If the value of this parameter is true, all data categorized as run time is exported (information contained in the DAC Setup view). Otherwise, this parameter is ignored.

Export DAC Metadata by Categories
The EXPORTCATEGORY option exports DAC metadata from the DAC repository based on the Logical, Run Time, or System categories.

Syntax:
EXPORTCATEGORY <folderName> <logicalFlag> <runtimeFlag> <systemFlag>

Create Schema
The CREATESCHEMA option creates the schema of a new DAC repository.

Syntax:
CREATESCHEMA <unicodeFlag> <workSpace name>

where:

unicodeFlag  If the value of this parameter is true, the schema is created as unicode. If the value is false, it is not created as unicode.
workSpace name  The name of the workspace in which the schema is created.

Drop Schema
The DROPSCHEMA option drops the schema of the DAC repository.
Common Tasks Performed in the DAC  ■ Replacing an Informatica Workflow with a Custom SQL File

Syntax:

DROP SCHEMA

**Analyze**

The ANALYZE option analyzes the DAC repository tables.

Syntax:

ANALYZE

**Upgrade**

The UPGRADE option upgrades the DAC repository.

Syntax:

UPGRADE

**Set Password**

The SETPASSWORD option sets the passwords for the Informatica servers and physical data sources in the DAC repository.

Syntax:

SETPASSWORD <type> <logicalName> <password>

**NOTE:** If the logical name or password contains spaces, quotes are required.

Replacing an Informatica Workflow with a Custom SQL File

You can improve the performance of loads by replacing Informatica workflows with custom SQL files.

**To replace an Informatica workflow with a custom SQL file**

1. Create a SQL file to be used to load the table, and unit test it.
2 Create an XML or SQL file with one or more SQL statements in the format that the DAC can understand.

   For more information about creating an XML or SQL file, see “Using SQL Files as an Execution Type in the DAC” on page 77.

   You can create one file for a full load and one for an incremental load, or you can use the same file for both full and incremental loads.

3 Save the file in the OracleBI\DAC\CustomSQLs directory.

4 In the Tasks tab of the DAC Design view, query for the task for which you want to replace the Informatica workflow.

5 Replace the workflow name in the Command for Incremental Load or Command for Full Load fields with the XML or SQL file.

6 Change the Execution Type to SQL.

**Determining the Informatica Server Maximum Sessions Parameter Setting**

You set the Maximum Sessions parameter value when you register the Informatica Server in the DAC client. This parameter specifies the maximum number of workflows that can be executed in parallel on the Informatica server. If the number of sessions is zero or is not specified, the DAC server assigns the default value of 10.

You should consider the following factors when determining the Maximum Sessions parameter value:

- How powerful the machine is that hosts the Informatica Server.
- How many Informatica Server servers are available.
The number of Runnable tasks in the queue. A Runnable task is a task for which the Depends On tasks have completed and is ready to be run but is waiting for an Informatica slot to be available. For information about the different task run statuses, see “About the DAC Current Run Tab” on page 119.

For an optimal run, the runnable queue should be at zero or should reach zero in a short time. For example, Figure 10 shows an ideal performance run when 15 sessions were run in parallel. There were many runnable tasks before the process began, but the queue soon reached zero.

You can generate a run analysis such as Figure 10 from the right-click menu (Get Run Information > Get Graph) on the DAC Current Run and Run History tabs. If you find that the runnable curve does not reach zero in a short time, you should increase the Maximum Sessions parameter value to make more Informatica slots available.

![Figure 10. Sample Performance Run](image_url)
Determining the Number of Transactional and Data Warehouse Database Connections

This section describes how to determine the maximum number of database connections you need between the DAC server and the transactional database and the DAC server and the data warehouse database. You set the Max Num Connections parameter when you create the transactional and data warehouse database connections.

For the transactional database, the DAC server uses these connections to perform change capture. The number of connections you set for this connection pool determines how many change capture processes can run concurrently. If you have a powerful transactional database server and are going to run ETL processes during off-peak times, you can increase the Max Num Connections setting to 15 or 20 (10 is the default). If you have a less powerful transactional database server, you should not overload the operational system with ETL processes. Therefore, you should set the value below 10.

For the data warehouse database, the DAC server uses these connections to perform processes such as truncate tables, drop and create indices, and analyze tables. You should not set the Max Num Connections value higher than the Maximum Sessions parameter value (the maximum number of workflows that can be executed in parallel on the Informatica server) because these values have a one to one relationship.

Running Two DAC Servers on the Same Machine

You can run two DAC servers on the same machine as long as they are listening on different ports and pointing to two different repositories.

To run two DAC servers on the same machine

1. Install instances of the DAC server in two different directories.
2. For each instance, edit the config.bat file to set the DAC_HOME variable appropriately.
3. Launch each of the DAC clients by navigating to the DAC directories and double-clicking the startclient.bat file.
4. For each instance, configure the DAC repository connection.
      An informational dialog box states this operation should be performed on the machine running the DAC server. It asks whether you want to continue.
      b. Click Yes.
   c. In the Repository Connection Information tab, enter the appropriate information for each instance. The Database Host should be the same for each instance, and the Database Port should be different.
5 For each instance, set up the DAC server system properties.
   a Navigate to Setup > DAC System Properties.
   b Set the DAC Server Host, OS, and Port properties.
6 Start each DAC server from its directory.

**Customizing Index and Analyze Table Syntaxes**

The customsql.xml file, located in the OracleBI\DAC\CustomSQLs directory, contains the syntax for dropping and creating indexes and analyzing tables. You can edit the customsql.xml file to change the behavior of these operations.

**To edit the Analyze Table syntax**

1 Open the customsql.xml file located in the OracleBI\DAC\CustomSQLs directory.
2 Locate the Analyze Table syntax for the appropriate database type.

   For example, the syntax for an Oracle database is as follows:

   ```xml
   <SqlQuery name = "ORACLE_ANALYZE_TABLE" STORED_PROCEDURE = "TRUE">
       DBMS_STATS.GATHER_TABLE_STATS(ownname => '@TABLEOWNER', tabname => '%1',
       estimate_percent => 30, method_opt => 'FOR ALL COLUMNS SIZE AUTO', cascade => true )
   </SqlQuery>
   ``

3 Edit the syntax.

   For example, to gather statistics for only the indexed columns, edit the syntax as follows:

   ```xml
   <SqlQuery name = "ORACLE_ANALYZE_TABLE" STORED_PROCEDURE = "TRUE">
       DBMS_STATS.GATHER_TABLE_STATS(ownname => '@TABLEOWNER', tabname => '%1',
       estimate_percent => 30, method_opt => 'FOR ALL INDEXED COLUMNS', cascade => true )
   </SqlQuery>
   
   **NOTE:** The variables @TABLEOWNER, %1, %2, and so on, will be substituted appropriately by the DAC when the statement is executed.

**To edit the Create Index syntax**

1 Open the customsql.xml file located in the OracleBI\DAC\CustomSQLs directory.
2 Locate the Create Index syntax for the appropriate database type, and edit the syntax.
Using SQL Files as an Execution Type in the DAC

There are two types of custom SQL files that can be executed through the DAC: XML formatted .xml files, and plain text .sql files. For examples of XML and SQL files, go to the Oracle BI\DAC\CustomSQLs folder.

XML Formatted Files
An XML file consists of a set of SQL statements for which the name, type, and Continue on Fail option are defined using XML attributes. The set of SQL statements is in a CDATA section which allows for special characters (like <, >, \) to be used without breaking the XML structure. A CDATA section looks like the following:

`<![CDATA[this is a place for a SQL statement]]>`

An example of an XML file follows:

```xml
<?xml version="1.0"?>
<CustomSQLs>
  <sql name="Create Temp" type="SQL" continueOnFail="true">
    <![CDATA[CREATE TABLE w_etl_temp (row_wid varchar(50))]]>
  </sql>
  <!-- This is how a comment section looks in XML -->
  <!-- It will be ignored-->
  <sql name="Update Temp" type="SQL">
    <![CDATA[UPDATE w_etl_temp SET row_wid = 'qwe' WHERE row_wid LIKE '5*']]>
  </sql>
  <sql name="Drop Temp" type="SQL">
    <![CDATA[DROP TABLE w_etl_temp]]>
  </sql>
</CustomSQLs>
```

This example consists of three SQL statements: Create Temp, Update Temp, and Drop Temp. These names will be used in DAC run task detail description to give details of the errors encountered during execution (if any). In this particular example all three statements are of type SQL. Regular update SQL statements and the Stored Procedure type can also be used.

If the Continue on Fail option is set to True for a given statement, the execution will continue even if the task fails. If the Continue on Fail option is set to False for a given statement, or is omitted, the subsequent statements will not be executed and the Task Run status will be Failed.
Plain Text SQL Files
Plain text SQL files consist of a set of SQL statements (no stored procedure calls). The SQL statements are separated by a semicolon (;), and comment tags are allowed (//, /* comment */ , -- ). If any of the SQL statements fail, the Task Run status will be Failed.

An example of a plain text SQL file follows:

```sql
CREATE TABLE w_etl_temp (name varchar(50))
;
UPDATE w_etl_temp
SET name = 'that's right' //this line demonstrates the use of ' in a text area
WHERE name LIKE 'gone fishing%';

/*
*some
*query
*statement
*/
SELECT * FROM w_etl_temp
;
DROP TABLE w_etl_temp
;
/*end of file*/
```

Overview of Change Capture Process (Siebel Sources Only)
This section describes the change capture process used to extract data from the Siebel transactional database. It includes the following topics:
Initial Data Capture

For each Siebel transactional source table (S_) from which data is extracted, there is one S_ETL_I_IMG_table and one S_ETL_R_IMG_table.

The first time a staging table is extracted, rows that are in the specified period are selected and inserted into the appropriate S_ETL_R_IMG_table. The specified period is set in the Prune Days parameter, in the Execution Plans tab. For more information about the Prune Days parameter, see "About the DAC Execution Plans Tab" on page 115.

Change Capture Mechanisms

There are two kinds of change capture mechanisms used:

- Change capture using tables
  This is the most common method. It uses S_ETL_I_IMG_ and S_ETL_R_IMG_ table types and the LAST_UPD column of the source tables.

- Change capture using the date column
  In some cases, a predefined date column is used to enable change capture (without use of S_ETL_I_IMG_ and S_ETL_R_IMG_ tables).

Change Capture Using Tables

When S_ tables are extracted, the process looks for row ID information (the combination of ROW_ID and MODIFICATION_NUM from the S_ table) that does not exist in the row image table (S_ETL_R_IMG_) and in columns where the value for LAST_UPD is more recent than that of LAST_REFRESH_DATE minus the Prune Days parameter setting. This information is inserted into S_ETL_I_IMG_table. The S_ETL_I_IMG_table is joined with the base table during the SDE extraction process to extract only the change capture rows during refresh.

S_ETL_R_IMG tables store the ROW_ID, MODIFICATION_NUM, and LAST_UPD for the rows in the S_ table that have the LAST_UPD in the defined Prune Days period. The LAST_UPD column is used to delete the records from the S_ETL_R_IMG_table. Records are deleted as soon as they go beyond the Prune Days period. This table is used to make sure that records that fall in the Prune Days period are not captured as updates unless they have actually been updated. This guarantees an efficient and faster change capture refresh. For information about tracking deleted records, see Once the ETL process is completed, the data from the change capture image tables (S_ETL_I_IMG_) is pushed into the row image (S_ETL_R_IMG) table. The S_ETL_R_IMG_ information is subsequently used in the next refresh.
Although the LAST_UPD column in Siebel transactional tables is used for change capture, the timestamp reflects the time the data is committed in the database, rather than the actual transaction event time. This may happen because of remote synchronization, handheld synchronization, UTC conversion, and other processes in which there may be a significant lag between the time of a transaction and its commitment to the database. It is possible, therefore, for a data row to get committed to the transactional database with a LAST_UPD date that is older than the date on which last refresh was executed. Consequently, if the extract is based purely on the date in LAST_UPD, some rows might be missed during extraction.

The LAST_UPD date column, however, still permits change capture process efficiency by limiting the number of rows that have to be compared. The rows from transactional tables are filtered based on the LAST_UPD date being more recent than the LAST_REFRESH_DATE, minus the prune days. Then the ROW_ID and MODIFICATION_NUM combination is compared with the row image table to discover the changed records.

The Prune Days parameter ensures that the rows having LAST_UPD values older than LAST_REFRESH_DATE are not missed. This is a parameter that customers can set based on experience with processes (such as remote synchronization) that may cause records to be missed.

Primary and Auxiliary Tables
The DAC performs change capture for both primary and auxiliary tables. When more than one source table is involved, then both the auxiliary and primary table records need to be marked as changed. For auxiliary tables, you need to write auxiliary mappings to mark the primary tables as changed. The SQL queries that do this are part of the mapping SDEINC_FindAux_.

The extract logic sometimes requires that rows be considered as changed, even if the record has not been updated in the primary table (and therefore extracted during the SDE process). This situation occurs when child table rows have changed and the header/master rows need to be extracted so that data warehouse tables are loaded with a consistent set.

When the S_CONTACT_X row is changed, the corresponding S_CONTACT also needs to be extracted. In this case, rows in S_CONTACT are also marked as changed by inserting rows in the change capture row image table.

When the S_ORDERITEM row is changed, the corresponding S_DOC_ORDER also needs to be extracted. In this case, rows in S_DOC_ORDER are also marked as changed (by inserting rows in the change capture row image table).

These auxiliary changes capture processes are heavily dependent on the data warehouse data model and are required to support the ETL logic.

Example: Building S_ETL_I_IMG_ Table for Loading Account Dimension
This section gives an extended example of the process of change capture using tables.
1 Load image tables for all relevant source tables.

The content of this entity comes from the S_ORG_EXT and S_ORG_EXT_X tables. Whenever any of the rows change in either of these tables, the record is marked as changed.

The image table for S_ORG_EXT is S_ETL_I_IMG_26. The image table prefix can be found using the DAC to view any source table. This table is truncated before loading with fresh data during every refresh.

During the ETL, process rows are inserted into S_ETL_I_IMG_26 by selecting ROW_ID information from S_ORG_EXT, for rows (combined ROW_ID and MODIFICATION_NUM) that do not exist in the S_ETL_R_IMG_26 and for which LAST_UPD is more recent than LAST_REFRESH_DATE minus the Prune Days setting. This is done during the ETL execution by the DAC’s internal image building tasks.

Similarly, the image table S_ETL_I_IMG_27 for S_ORG_EXT_X is loaded.

2 Load the image table for auxiliary table-based changes.

In addition to the basic change capture, extra processing might be required due to special ETL requirements. In this example, it happens that S_ORG_EXT needs to be extracted for processing even if only S_ORG_EXT_X changes. This is because both the tables are joined to form W_ORG_D, and the extract process of W_ORG_D (a SDE mapping) looks for a changed ROW_ID in the change capture row image table for the primary table S_ORG_EXT only. Therefore, the extract happens only when the ROW_ID for S_ORG_EXT exists in the row image table.

In this case, the SDEINC_FindAux_ mapping is needed to insert corresponding rows of S_ORG_EXT.ROW_ID in the change capture row image table whenever S_ORG_EXT_X changes. The following logical statement shows the method:

Identify the records that have changed in the S_ORG_EXT_X (rows in S_ETLI_IMG_27) table and then find the corresponding rows in S_ORG_EXT. Insert the ROW_ID and MODIFICATION_NUM of those corresponding rows from S_ORG_EXT into S_ETL_I_IMG_26 table.

Using Informatica, the auxiliary mapping SDEINC_FindAux_ has to be written for each primary table that requires it, depending on data warehouse extract logic. Using the DAC, this auxiliary task has to be linked as a parent to the extract mapping for the base table (S_ORG_EXT in this case).

This is the SQL override for the SDEINC_FindAux Informatica mapping:

```sql
SELECT
    S_ORG_EXT.ROW_ID,
    S_ORG_EXT.MODIFICATION_NUM,
    S_ORG_EXT.LAST_UPD
FROM
    S_ORG_EXT,
    S_ORG_EXT_X,
```
### 3 Extract source table information using change capture image information.

After the records that are new or modified are identified, those rows are loaded into the staging tables. The Informatica mappings that load the staging tables use the ROW_ID information captured in the image tables.

This example shows the loading of staging table W_ORG_DS. The main logic of populating this table lies in the SQL override of the mapping SDE_OrganizationDimension.

The DAC creates views on tables that are being extracted. The views are different, depending on whether a table is extracted the first time or is a change capture extract.

- **If extracting for the first time**, the view is created as `SELECT * FROM S_ORG_EXT`.
- **If it is a change capture extract**, the view is created as `SELECT * FROM S_ORG_EXT, S_ETL_I_IMG_26 IMG WHERE S_ORG_EXT.ROW_ID = IMG.ROW_ID`.

The SQL override in the mapping uses the view to extract the data.

```sql
SELECT
  S_ORG_EXT.ROW_ID,
  S_ORG_EXT.NAME, ....
  ....
FROM
```
Common Tasks Performed in the DAC ■ Overview of Change Capture Process (Siebel Sources Only)

Overview of Change Capture Process

Oracle Business Intelligence Data Warehouse Administration Console Guide
Version 7.9

83

V_ORG_EXT,
S_ORG_EXT_X,
....
WHERE
{
    V_ORG_EXT S_ORG_EXT
    LEFT OUTER JOIN S_ORG_EXT_X ON
    S_ORG_EXT.ROW_ID = S_ORG_EXT_X.PAR_ROW_ID
    ....
}
AND
S_ORG_EXT.ROW_ID <> 'INT_COMPANY_ID'

Change Capture Using the Date Column
Forecasts are extracted without using the image table. The value S_FCSTSER_DATE is tracked using the date column ARCHIVE_TS. The administrator sets the ARCHIVE_TS for forecasts that are submitted, frozen, and ready to be loaded into the Oracle Business Analytics Warehouse. S_ETL_RUN stores the previous ETL date when forecasts were extracted and the current ETL date when the forecasts are being extracted. All forecasts with ARCHIVE_TS values greater than that of the previous ETL date and ARCHIVE_TS (less than the current ETL date) are extracted in the current ETL. Both ETL date and ARCHIVE_TS (less than the current ETL date) are stored in S_ETL_CURR_RUN.

NOTE: Forecasts in the Oracle Business Analytics Warehouse are never updated. Once loaded, they are frozen.

SELECT
....
FROM
    S_FCSTSER_DATE,
    S_FCSTSER,
    S_ETL_CURR_RUN,
    ....
WHERE
    S_FCSTSER_DATE.FCSTSER_ID = S_FCSTSER.ROW_ID
    AND S_FCSTSER_DATE.ARCHIVE_TS > S_ETL_CURR_RUN.PREV_LOAD_DT
AND S_FCSTSER_DATE.ARCHIVE_TS <= S_ETL_CURR_RUN.LOAD_DT

Using the Change Capture Filter

The change capture filter allows you to selectively load data from the Siebel transactional database into the data warehouse. You can set a condition in the ChangeCaptureFilter.xml file to filter data from specific tables. This file is located in the OracleBI\DAC\CustomSQLs directory. It provides an XML sample that you can copy and alter to fit your needs. Detailed instructions for using this feature are included at the top of the file.

Tracking Deleted Records

The Oracle Business Analytics Warehouse change capture process uses delete triggers to identify records for deletion on the Siebel transactional database. The deleted records are stored in S_ETL_D_IMG tables. During the change capture process, the DAC server moves the data from the S_ETL_D_IMG tables to the S_ETL_I_IMG tables, where D appears in the OPERATION column to show the records were deleted. During the change capture sync process, the records in the S_ETL_D_IMG tables that were moved to the S_ETL_I_IMG tables are flushed. In the DAC, you can view the SQL that runs during the change capture and change capture sync processes by using the Output to File right-click command in the Tasks tab of the Design view.

The preconfigured ETL process captures deleted records for the target tables W_ORG_D and W_PERSON_D, the source tables for which are S_ORG_EXT, S_CONTACT, and S_PRSP_CONTACT. These source tables need to have delete triggers created in the Siebel transactional database in order for deleted records to be tracked.

For vertical applications, the preconfigured ETL process captures deleted records for W_FUND_F and W_ALIGNMT_DH. You need to create delete triggers in the transactional database for the following additional tables: S_MDF_TXN, S_ASGN_GRP_POSTN, S_ASGN_RULE_ITEM.

In the Oracle Business Analytics Warehouse, preconfigured visibility tables are inactivated. If you activate visibility tables, you should also create delete triggers on the optional tables.

The preconfigured SIA Account and Contact visibility tables are activated by default for vertical applications. If your organization is not going to use any of the visibility tables, you need to inactivate them in the DAC.

On the target tables for which deleted records are tracked, a D appears in the INACTIVE_FLG column to show the records as deleted when the source records are deleted. This method of flagging a record as deleted is known as a soft delete, as compared to a hard delete when the record is physically deleted. When deleted records are tracked on visibility-related data warehouse tables, the records are physically deleted. The general rule is that soft deletes should be used for tables that are referenced by other tables. If a table is not referenced by any other table, then you can use hard deletes.
Aggregate tables are rebuilt during each ETL process. Therefore, records can be physically deleted from the base tables without consequence. If you want to use the soft delete method, you should consider changing the aggregate building mappings so that the deleted records are omitted.

**NOTE:** The Oracle BI Server does not recognize soft deletes. Therefore, you have to modify the .rpd file so that it does not pick up soft-deleted records for reporting.

**To create delete triggers for preconfigured ETL change capture**

1. From the DAC menu bar, click Tools > ETL Management > Configure.
2. In the Sources dialog box, select the database platform for the target and transactional databases, and click OK.
3. In the Data Warehouse Configuration Wizard, select the Create Delete Triggers in Transaction Database check box, and click Next.
   The Delete Triggers tab is active.
4. Select one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Triggers</td>
<td>Executes the trigger statements directly.</td>
</tr>
<tr>
<td>Write Script to File</td>
<td>Writes the trigger statements to a file, which can be executed by a database administrator.</td>
</tr>
</tbody>
</table>

5. Select the database type as defined in the DAC.
6. For DB2 zSeries databases, enter the base table owner.
7. (Optional) Select the Include Optional Triggers check box to create triggers for the optional tables.
8. Click Start.

**To create delete triggers for new source tables**

1. In the DAC, navigate to Design > Tables.
2. Select the table for which you want to track deleted records.
   Make sure the table has an image suffix.
4. In the Triggers and Image Tables dialog box, select the database type of the source database.
5. Make sure the Generate Image Table Scripts and Generate Trigger Script(s) options are selected.
6. Execute the script on the database.
To track deleted records

1. Make sure the delete triggers are enabled for the appropriate tables.
2. Write custom Informatica workflows with a clause WHERE operation = ‘D’ to the appropriate I_IMG table to take them across to the dimension and fact tables.
3. In the DAC, register the workflows as tasks.
4. Define the appropriate dependencies.
   For an example of such a workflow, see the preconfigured task SDE_OrganizationDimension_LoadDeletedRows.

Handling ETL Failures with the DAC

This section includes the following topics:

- When the Execution of an Execution Plan Fails on page 86
- Discarding the Current Run Execution Plan on page 87
- Failure of Aggregator Transformation Tasks with Sorted Input on page 87

When the Execution of an Execution Plan Fails

When an execution plan is executed, if a task fails, the status of the tasks that are dependent on the failed task is changed to Stopped. While tasks are still running, the execution plan’s status is Running. When all the tasks have been run, and if one or more tasks have failed, the execution plan’s status is changed to Failed.

You can check the tasks that have failed in the Current Run tab of the Execute view, fix the problems, and then requeue the failed tasks by changing the status to Queued. You can then restart the ETL. All the tasks will then be rerun. You can also manually run a task, change its status to Completed, and then restart the ETL. Tasks with a Completed status are skipped.

**CAUTION:** The DAC server does not validate tasks that have been run manually.

To restart a Failed ETL, click Run Now from the Current Run tab of the Execute view.

In Case of Abnormal Termination of the DAC Server

If the DAC server fails during the execution of the ETL, the status of the ETL execution will remain as Running. When the DAC server is started again, it will automatically run the ETL if the Auto Restart ETL DAC system property is set to True. If the same system property is set to False, when the server restarts, it will set the correct status as Failed. In order to execute the ETL from the point of failure, submit the request to the server again.

The DAC server will automatically terminate if it loses connection to the DAC repository.
Discarding the Current Run Execution Plan
You can discard an execution plan that failed by navigating to the Current Run tab, right-clicking on the execution plan and changing its status to Mark as Completed. This will force the run status to be updated as Completed. When you submit a request for another run, the DAC server creates another instance of it.

CAUTION: Perform this procedure in a development or testing environment only, since it might leave the data in an inconsistent state, causing you to have to reload all of the data.

Failure of Aggregator Transformation Tasks with Sorted Input
Tasks that use Informatica Aggregator transformation can fail when the Sorted Input option is active. The tasks SDE_DTLFORECASTFACT and SDE_COSTLIST are examples of tasks that can fail in such a situation.

To prevent such tasks from failing, in Informatica Designer, navigate to Mapping Designer, open the corresponding mapping, and in the Aggregator transformation, remove the check from the Sorted Input check box.
Common Tasks Performed in the DAC

Handling ETL Failures with the DAC
This chapter describes the functionality available in the Data Warehouse Administration Console (DAC). It contains the following topics:

- Common Elements of DAC Interface Tabs on page 89
- About the DAC Design View on page 89
- About the DAC Setup View on page 106
- About the DAC Execute View on page 114

### Common Elements of DAC Interface Tabs

Some of the DAC interface tabs have common elements, such as columns or child tabs. Table 13 provides a description of these common elements.

<table>
<thead>
<tr>
<th>Column or Child Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A column that specifies the name of the repository, warehouse, or transactional database object.</td>
</tr>
<tr>
<td>Inactive</td>
<td>A column that indicates whether an object is inactive. Inactive objects do not participate in the ETL process.</td>
</tr>
<tr>
<td>Owner</td>
<td>A column that specifies the source system container in which the object was created.</td>
</tr>
<tr>
<td>Edit</td>
<td>A child tab that allows you to edit an object that is selected in the top pane window.</td>
</tr>
<tr>
<td>Description</td>
<td>A child tab that displays and allows you to edit a description of the object selected in the top pane.</td>
</tr>
</tbody>
</table>

### About the DAC Design View

The DAC Design view provides access to functionality related to creating and managing subject areas.

This section includes the following topics:

- About the DAC Subject Areas Tab on page 90
- About the DAC Tables Tab on page 92
- About the DAC Indices Tab on page 94
About the DAC Subject Areas Tab

The Subject Areas tab lists all the subject areas associated with the selected source system container. It allows you to view and edit existing subject areas and to create new ones. Table 14 provides a description of the properties in the top pane of the tab.

Table 14. DAC Subject Areas Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tag tasks only</td>
<td>Indicates whether configuration tag tasks are the only tasks associated with this subject area that will participate in the ETL process. If this check box is selected, only the tasks associated with the configuration tag will be chosen by the DAC when the subject area is assembled. For more information about Configuration Tag tasks, see “About the DAC Configuration Tags Tab” on page 105.</td>
</tr>
<tr>
<td>Last Designed</td>
<td>Date and time the subject area was last assembled.</td>
</tr>
</tbody>
</table>
Table 15 provides a description of the child tabs in the bottom pane of the Subject Areas tab.

<table>
<thead>
<tr>
<th>Child Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tasks          | Displays the tasks associated with the selected subject area, and allows you to add tasks to a subject area, inactivate tasks, and remove tasks from a subject area.  
  *NOTE:* When you *inactivate* a task, it remains inactive even if you reassemble the subject area. When you *remove* a task from a subject area, it will be added back to the subject area upon reassembly.  
  It includes the following properties:  
  ■ **Parent Group.** If the task belongs to a task group, this column displays the task group name.  
  ■ **Phase.** Task phase of the ETL process.  
  ■ **Autogenerated.** Indicates whether the task was automatically generated by the DAC’s task generation process.  
  ■ **Is Group.** Indicates whether the task is a task group. |
| Tables         | Displays the tables that are associated with the selected subject area. It allows you to add tables to subject areas or to remove them.                                                                         |
| Configuration Tags | Displays the configuration tags that are associated with this subject area.  
  It includes the following properties:  
  ■ **Include Tasks.** This field is read-only. It indicates whether the configuration tag tasks will be executed with the selected subject area.  
  ■ **Context Disabled.** If this check box is selected, the configuration tag is globally disabled (set as Inactive in the Configuration Tags parent tab). |
About the DAC Tables Tab

The Tables tab lists all the tables associated with the selected source system container. It allows you to view and edit existing tables and to create new ones. Table 16 provides a description of the table properties in the top pane of the tab.

Table 16. DAC Tables Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Type</td>
<td>Indicates the type of table.</td>
</tr>
<tr>
<td>Warehouse</td>
<td>Indicates whether the table is a warehouse table.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the warehouse flag is not selected, the schema creation process will not include this table.</td>
</tr>
<tr>
<td>Image Suffix</td>
<td>Suffix for image tables. Applicable to Siebel source tables only. For more information about image tables, see “Generate Image and Trigger Scripts Command” on page 93.</td>
</tr>
<tr>
<td>Is MultiSet</td>
<td>Indicates whether the table is a MultiSet table. Applicable only to Teradata databases.</td>
</tr>
<tr>
<td>Has Unique Primary Index</td>
<td>Indicates whether the table has a Unique Primary Index. Applicable only to Teradata databases.</td>
</tr>
</tbody>
</table>

Table 17 provides a description of the child tabs in the bottom pane of the Tables tab.

Table 17. DAC Tables Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related Tables</td>
<td>Lists tables that are related to the selected table. Related tables participate in the ETL process in addition to the tables that are associated with this table.</td>
</tr>
<tr>
<td>Columns</td>
<td>Lists the columns associated with the selected table and allows you to add columns to the selected table. Also allows you to enter foreign key table and foreign key column relationships.</td>
</tr>
<tr>
<td>Multi-column Statistics</td>
<td>Applicable to Teradata databases only.</td>
</tr>
<tr>
<td>Indices (RO)</td>
<td>Displays a read-only list of indices that belong to the selected table.</td>
</tr>
<tr>
<td>Source for Tasks (RO)</td>
<td>Displays a read-only list of tasks that use the selected table as a source.</td>
</tr>
<tr>
<td>Target for Tasks (RO)</td>
<td>Displays a read-only list of tasks that use the selected table as a target.</td>
</tr>
<tr>
<td>Conditional for Tasks (RO)</td>
<td>Displays a read-only list of tasks that are optional tasks for the selected table.</td>
</tr>
</tbody>
</table>
**Actions Available**
The following actions are available in the top pane toolbar and in the right-click menu when the Tables tab is active.

**Generate Index Scripts Command**
This command generates drop index, create index, and analyze table scripts for all the tables that participate in the ETL process. You can query for one or more tables, and the command will generate all the scripts for all the tables. The results are stored in the log\scripts directory. Files are generated that provide the following information: drop indices of type ETL, create indices of type ETL, drop indices of type Query, create indices of type Query, and analyze tables.

**Generate Image and Trigger Scripts Command**
This command generates change capture scripts for tables with defined image suffixes (Siebel sources only). The scripts include creation of the image tables to assist in the change capture process and their indices. You can also create the triggers for deletes. Triggers for deletes should be used only for new source tables for which you want to use change capture. The scripts will be generated for the selected table or all the tables shown in the list applet. You can narrow down the tables of interest by querying. The results are shown in a text box, which can be supplied to the DBA for executing.

**Generate View Scripts**
This command generates change capture view scripts for full or incremental loads for any table that participates in the change capture process. This command can be useful when the change capture fails and you want to run a task manually. It can also be used for unit testing.

**Generate Change Capture SQL**
This command generates change capture SQL scripts for full or incremental mode for tables that participate in the change capture process. This command can be useful when the change capture fails and you want to run a task manually. It can also be used for unit testing.

**Import Database Tables Command**
This command allows you to import table definitions from a selected database. This command does not allow you to import table column definitions. You need to use the Import Database Columns command to do so.

**Import Database Columns Command**
This command allows you to import table column definitions.
Import Indices Command
This command allows you to import index definitions from the database for one or more tables as listed in the result of the query.

**NOTE:** In MSSQL Server databases, when you import indices with columns whose sort order type is “Desc,” the sort order type appears in the DAC as “Asc.” You have to set the sort order manually to “Desc.”

### About the DAC Indices Tab

The Indices tab displays a list of all the indices associated with the selected source system container. It is recommended that you do not register any indices for source tables. During the ETL process, when a table is going to be truncated, all the indices as defined in the repository will be dropped before the data is loaded and will be created after the data is loaded automatically. While this improves the ETL performance, the preconfigured workflows have the bulk load option turned on. The bulk load will fail if there are indices on the table. Therefore, it is important to keep the index definitions in sync with the database. For example, if you create an index on the database, and it is not registered in the repository, the index will not be dropped and the load will fail.

For Teradata databases, only secondary indices should be registered in the DAC. You should not register primary indices or the more complex indices, such as single- and multi-table indices, because they cannot be dropped and recreated. You can use SQL commands to drop and create such tasks in the DAC.

Table 18 provides a description of the index properties displayed in the top pane of the Indices tab.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Table for which an index is created.</td>
</tr>
<tr>
<td>Index Usage</td>
<td>Usage of index: ETL or Query. An ETL index is typically used during the ETL process. A Query index is an index used only during the reporting process. It is recommended that you have a clear understanding of when and where the index will be used at the time of registering the index.</td>
</tr>
<tr>
<td>Databases</td>
<td>Allows you to associate an index with a database type.</td>
</tr>
<tr>
<td># Unique Columns</td>
<td>For unique indices, the number of columns that will be unique.</td>
</tr>
<tr>
<td>Is Unique</td>
<td>Indicates whether the index is unique.</td>
</tr>
<tr>
<td>Is Clustered</td>
<td>Indicates whether the index is clustered. There can be only one clustered index per table.</td>
</tr>
<tr>
<td>Is Bitmap</td>
<td>Indicates whether the index is of the bitmap type.</td>
</tr>
</tbody>
</table>
Table 19 shows which index properties are available for the different database types that are supported.

Table 19. Index Properties and Database Types Matrix

<table>
<thead>
<tr>
<th>Column/Database</th>
<th>Is Unique</th>
<th>Is Clustered</th>
<th>Is Bitmap</th>
<th>Allow Reverse Scan</th>
<th># Unique Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DB2</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>DB2-390</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSSQL</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 20 provides a description of the child tabs in the bottom pane of the Indices tab.

Table 20. Indices Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Displays the list of columns the index is made of.</td>
</tr>
<tr>
<td></td>
<td>It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Position.</strong> Position of the column in the index.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Sort Order.</strong> Indicates whether the sort order is ascending or descending.</td>
</tr>
<tr>
<td>Databases</td>
<td>Lists the database types that apply to the selected index. If no database type is indicated, the index will not be created.</td>
</tr>
</tbody>
</table>
**Database Filter**

The database filter appears in the Indices tab to the right of the top pane toolbar, as shown in Figure 11. Click on the words “Database Type” to open the Index Filtering dialog box. It allows you to filter the set of displayed indices based on the database type. To display all indices regardless of database type, select the option All.

![Figure 11. Indices Tab Database Filter](image)

**About Advanced Custom Index Management**

The DAC allows you to drop and recreate indices during the load process, which reduces the overall load time during a full load. The DAC drops and recreates indices based on the index definitions stored in the DAC metadata.

**NOTE:** More advanced index management needs to be handled outside of the DAC, such as creating partitioned indices on Oracle databases, which requires specific syntax, and creating single-table and multi-table join indices on Teradata databases. In such cases you can use DAC SQL tasks placed appropriately in the task dependencies, or you can use a pre-session or post-session script in Informatica. You must drop the partitioned index before a task runs to load data using the bulk loader, because the bulk loader may fail if there are indices on the target database.

If you need to modify the preconfigured indices with extra options or syntax, you must inactivate them in the DAC metadata so that the DAC server does not try to drop and recreate them. You can then manage these indices in the same manner as the advanced index management described above.
About the DAC Tasks Tab

The Tasks tab lists all the tasks associated with the selected source system container. Table 21 provides a description of the task properties displayed in the list of the top pane of the Tasks tab.

Table 21. Tasks Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Group</td>
<td>If the task is a member of a group, this field lists the task group name.</td>
</tr>
<tr>
<td>Command for Incremental Load</td>
<td>A table can be loaded in Full Mode or Incremental Mode. Full Mode refers to data loaded for the first time or data that is truncated and then loaded. Incremental Mode refers to new or changed data being added to the existing data. The DAC maintains a last refresh timestamp whenever a table is changed during the ETL process. (You can view this timestamp under Setup &gt; Physical Data Sources &gt; Refresh Dates.) If a table has a timestamp, the command appearing in this column is executed. If a table does not have a timestamp, the command for a full load is executed. If the execution type is Informatica, the workflow name is used as the command.</td>
</tr>
<tr>
<td>Command for Full Load</td>
<td>If a table has no last refresh timestamp, this command is executed.</td>
</tr>
<tr>
<td>Folder Name</td>
<td>Only for execution type of Informatica. The folder in which the workflow resides. <strong>NOTE:</strong> The name cannot contain spaces.</td>
</tr>
<tr>
<td>Primary Source</td>
<td>Logical database connection for the primary source database.</td>
</tr>
<tr>
<td>Primary Target</td>
<td>Logical database connection for the primary target database.</td>
</tr>
<tr>
<td>Task Phase</td>
<td>Task phase of the ETL process. This information is primarily used for dependency generation. Certain phases, such as Change Capture and Query Index Creation, are not available for you to assign to a task. The DAC server uses the task phase to prioritize tasks and to generate a summary of the time taken for each of the phases.</td>
</tr>
</tbody>
</table>
Execution Type

- **Informatica.** Task is invoked on an Informatica Server using pmcmd.
- **External Program.** Task is an operable program on the operating system where the DAC server is running. This program can be a batch file, shell script, or any other program that can be run like a bulk loader.
- **SQL File.** Task is a SQL script in .xml or .sql format.
- **Stored Procedures.** Task is a stored procedure that has been defined on the databases.

In addition, there are several internal execution types that you will not be able to select when creating new tasks. These tasks are categorized as either internal change capture tasks or internal data warehouse tasks; all of these tasks are color-coded in pink in the Tasks tab.

- **IMG_BUILD - internal change capture.** If you are using multiple Siebel transactional sources, you cannot change the behavior of the change capture process. This task requires change capture tables to be created on the other sources also. When adding additional Siebel sources, go to Design > Tables, right-click and select Change Capture Tasks. This action generates change capture tasks. Use this same action to disable or delete change capture tasks.

- **IMG_SYNC - internal change capture.** If you are using multiple Siebel transactional sources, you can create this task for the additional tasks for doing similar change capture sync processes. You cannot change the behavior of the change capture sync process. This task requires change capture tables to be created on the other sources also. This task should be used with discretion for Siebel sources only.

- **QUERY_INDEX - internal data warehouse.** This task allows you to alter when the Query indices are created. The DAC server drops all indices before loading when the CreateQueryIndexAtTheEnd setting is set to True. When this setting is set to False, all the indices, regardless of the index type, get created as part of the task that does the loading.

- **UPDATE_ETL_PARAM - internal data warehouse.** This task is used only to update W_PARAM_G from the DAC server. This task populates the system properties to the W_PARAM_G table in the data warehouse by querying values defined in the DAC repository. Because only one data warehouse per DAC repository is supported, this execution type should not be chosen for any task.

Priority

Indicates the order in which the task runs. If two or more tasks have the same priority, the order occurs randomly.
### About the DAC Design View

**Pre-SQL for Full Load**
The SQL script (derived from a SQL or XML file) that is executed before the specified task when the task is participating in a full load.

**Pre-SQL for Incremental Load**
The SQL script (derived from a SQL or XML file) that is executed before the specified task when the task is participating in an incremental load.

**Post-SQL for Full Load**
The SQL script (derived from a SQL or XML file) that is executed after the specified task when the specified task is participating in a full load.

**Post-SQL for Incremental Load**
The SQL script (derived from a SQL or XML file) that is executed after the specified task when the specified task is participating in an incremental load.

**Build Image**
Applicable for Siebel transactional sources only. Indicates the change capture for the primary/auxiliary source tables will be executed.

**Analyze Tables**
The DAC automatically analyzes tables when tasks truncate tables. By selecting this check box, however, you can force the DAC to analyze tables even when they are not truncated.

**Continue on Error**
When this check box is selected, if the command fails, the dependent tasks are not stopped. However, if any autogenerated tasks fail, the dependent tasks are stopped.

---

### Table 21. Tasks Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-SQL for Full Load</td>
<td>The SQL script (derived from a SQL or XML file) that is executed before the specified task when the task is participating in a full load.</td>
</tr>
<tr>
<td>Pre-SQL for Incremental Load</td>
<td>The SQL script (derived from a SQL or XML file) that is executed before the specified task when the task is participating in an incremental load.</td>
</tr>
<tr>
<td>Post-SQL for Full Load</td>
<td>The SQL script (derived from a SQL or XML file) that is executed after the specified task when the specified task is participating in a full load.</td>
</tr>
<tr>
<td>Post-SQL for Incremental Load</td>
<td>The SQL script (derived from a SQL or XML file) that is executed after the specified task when the specified task is participating in an incremental load.</td>
</tr>
<tr>
<td>Build Image</td>
<td>Applicable for Siebel transactional sources only. Indicates the change capture for the primary/auxiliary source tables will be executed.</td>
</tr>
<tr>
<td>Analyze Tables</td>
<td>The DAC automatically analyzes tables when tasks truncate tables. By selecting this check box, however, you can force the DAC to analyze tables even when they are not truncated.</td>
</tr>
<tr>
<td>Continue on Error</td>
<td>When this check box is selected, if the command fails, the dependent tasks are not stopped. However, if any autogenerated tasks fail, the dependent tasks are stopped.</td>
</tr>
</tbody>
</table>
Table 22 provides a description of the child tabs in the bottom pane of the tab.

### Table 22. Tasks Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source Tables</strong></td>
<td>Displays the list of tables from which the selected task extracts data. It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type.</strong> Table type. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Primary.</strong> Indicates whether the table is a primary source of data.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Auxiliary.</strong> Indicates whether the table is a secondary source of data.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Lookup.</strong> Indicates whether the table is a lookup table.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Data Source.</strong> When a data source is not specified, the default is the task’s primary source.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If a table is marked as Primary or Auxiliary and the Build Image property of the task is selected, the change capture process is invoked. There are special tasks that force the base table data to be extracted when data in auxiliary tables change.</td>
</tr>
<tr>
<td></td>
<td>A table can be neither Primary nor Auxiliary but still be used for getting some attributes to populate a dimension or fact table. The changes in these kinds of source tables are not reflected in the dimension or fact table once the data is populated.</td>
</tr>
<tr>
<td><strong>Target Tables</strong></td>
<td>Displays the list of tables into which the selected task loads data. It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Data Source.</strong> If no data source is specified, this value defaults to the task’s primary target.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Truncate Always.</strong> Indicates the target tables will be truncated regardless of whether a full or incremental load is occurring. Any indices registered for this table are dropped before the command is executed and are recreated after the command completes successfully. When indices are dropped and created, the table is analyzed so that the index statistics are up-to-date.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Truncate for Full Load.</strong> Indicates the target tables will be truncated only when a full load is occurring. Any indices registered for this table are dropped before the command is executed and are recreated after the command completes successfully. When indices are dropped and created, the table is analyzed so that the index statistics are up-to-date. When the Truncate Always option is selected, this option is unnecessary.</td>
</tr>
</tbody>
</table>
Conditional Tables
Displays the tables that, if included in an execution plan, cause the optional task selected in the top pane to be executed.

For example, the Order Item fact table is a conditional table associated with the optional task called UpdateRecencyCat in Person Dimension. The UpdateRecencyCat in Person Dimension task is executed only when the Order Item fact table is included in an execution plan.

Phase Dependency
The DAC server uses the ETL phase property to prioritize tasks. By changing the phase property of a task, you change the task’s execution order.

For instructions on setting a phase dependency, see "Setting a Task Phase Dependency" on page 48.

This child tab includes the following properties.

■ Action. The action to be taken in relation to the phase dependency.
  Possible values are:
  ■ Wait. Indicates the selected task will wait to be executed until the tasks of a specified phase have been executed.
  ■ Block. Indicates the selected task will block all tasks of the specified phase from being executed until is has been executed.

■ Grain. Possible values are:
  ■ All. Indicates the action will affect all tasks.
  ■ Related. Indicates the action will affect only related tasks. You can view a task’s related tasks by navigating to Execution Plans > All Dependencies and viewing the specified task’s predecessor tasks.

■ Phase. The ETL phase that will apply to the Action and Grain properties.

Table 22. Tasks Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional Tables</td>
<td>Displays the tables that, if included in an execution plan, cause the optional task selected in the top pane to be executed. For example, the Order Item fact table is a conditional table associated with the optional task called UpdateRecencyCat in Person Dimension. The UpdateRecencyCat in Person Dimension task is executed only when the Order Item fact table is included in an execution plan.</td>
</tr>
<tr>
<td>Phase Dependency</td>
<td>The DAC server uses the ETL phase property to prioritize tasks. By changing the phase property of a task, you change the task’s execution order. For instructions on setting a phase dependency, see &quot;Setting a Task Phase Dependency&quot; on page 48. This child tab includes the following properties.</td>
</tr>
</tbody>
</table>

■ Action. The action to be taken in relation to the phase dependency. Possible values are:
  ■ Wait. Indicates the selected task will wait to be executed until the tasks of a specified phase have been executed.
  ■ Block. Indicates the selected task will block all tasks of the specified phase from being executed until is has been executed.

■ Grain. Possible values are:
  ■ All. Indicates the action will affect all tasks.
  ■ Related. Indicates the action will affect only related tasks. You can view a task’s related tasks by navigating to Execution Plans > All Dependencies and viewing the specified task’s predecessor tasks.

■ Phase. The ETL phase that will apply to the Action and Grain properties.
About the DAC Task Groups Tab

The Task Groups tab lists all the task groups associated with the selected source system container. A task can belong to only one group. Table 23 provides a description of the task group properties displayed in the top pane of the tab.

Table 23. Task Groups Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restart All on Failure</td>
<td>Indicates the tasks in this task group will be restarted if one or more tasks fails during an ETL process.</td>
</tr>
<tr>
<td>Execute Serially</td>
<td>Indicates the tasks in this task group will be executed sequentially. This property overrides the execution order.</td>
</tr>
</tbody>
</table>

About the DAC Design View

The Task Groups tab lists all the task groups associated with the selected source system container. A task can belong to only one group. Table 23 provides a description of the task group properties displayed in the top pane of the tab.
Truncate Always
Indicates the target tables are truncated regardless of whether a full or incremental load is occurring. Any indices registered for the target table are dropped before the command is executed and are recreated after the command completes successfully. When indices are dropped and created, the table is analyzed so that the index statistics are up-to-date.

**NOTE:** Make sure if you select this option that all the tasks write to the same data source.

Truncate for Full Load
Indicates the target tables will be truncated only when a full load is occurring. Any indices registered for the target table are dropped before the command is executed and are recreated after the command completes successfully. When indices are dropped and created, the table is analyzed so that the index statistics are up-to-date.
Table 24 provides a description of the child tabs in the bottom pane of the Task Groups tab.

### Table 24. Task Groups Child Tabs

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Child Tasks</strong></td>
<td>Lists the tasks that belong to the selected task group. It includes the following properties: <strong>Execution Order.</strong> Order among the tasks in the task group in which this task will be executed. If two or more tasks have the same execution order and the Execute Serially flag is not checked, the DAC will run the tasks in parallel.</td>
</tr>
<tr>
<td><strong>Source Tables</strong></td>
<td>Read only. Displays the tables used for getting data by the selected task group. It includes the following properties: <strong>Task.</strong> Task that extracts data from the table. <strong>Primary.</strong> Indicates whether the table is a primary source of data. <strong>Auxiliary.</strong> Indicates whether the table is a secondary source of data. <strong>Type.</strong> Source table type. <strong>NOTE:</strong> If a table is marked as Primary or Auxiliary and the Build Image property of the task is selected, the change capture process is invoked. There are special tasks that force the base table data to be extracted when data in auxiliary tables changes. A table can be neither Primary nor Auxiliary but still be used for getting some attributes to populate a dimension or fact table. The changes in these kinds of source tables are not reflected in the dimension or fact table once the data is populated.</td>
</tr>
<tr>
<td><strong>Target Tables</strong></td>
<td>Read only. Displays the tables into which the task group (selected in the top pane) loads data. It includes the following properties: <strong>Table.</strong> Name of the target table. <strong>Task.</strong> Task that loads data into the target table. <strong>Primary.</strong> Indicates whether the table is a primary target table. For documentation purposes only. <strong>Auxiliary.</strong> Indicate whether the table is a secondary target table. <strong>Type.</strong> Target table type.</td>
</tr>
</tbody>
</table>
About the DAC Configuration Tags Tab

A configuration tag is an object that controls the inclusion of tasks in subject areas. When a task is tagged, it is not eligible to be included in the collection of tasks for any subject area, unless the tag is part of the subject area definition “Include Task” property.

A configuration tag can function in one of the following ways:

- **Remove tasks from all subject areas**
- **Reassign autogenerated tasks to a specific subject area**
- **Add non-autogenerated tasks to a subject area**

For instructions on creating configuration tags, see "Working with Configuration Tags" on page 51.

Table 25 provides a description of the columns in the top pane of the Configuration Tags tab.

Table 25. Configuration Tags Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Tasks</td>
<td>If this check box is selected, the tasks that are assigned to a configuration tag will participate in the ETL process for the subject area to which this configuration tag is assigned. For example, suppose Configuration Tag 1 is made up of Task 1 and Task 2, and Configuration Tag 1 is assigned to Subject Area 1. Task 1 and Task 2 will be executed when the execution plan for Subject Area 1 is executed, whether or not Task 1 and Task 2 relate to the tables that make up the subject area.</td>
</tr>
</tbody>
</table>

Table 26 provides a description of the child tabs in the bottom pane of the Configuration Tags tab.

Table 26. Configuration Tags Child Tabs

<table>
<thead>
<tr>
<th>Child Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject Areas</td>
<td>This child tab allows you to assign a configuration tag to a subject area.</td>
</tr>
<tr>
<td></td>
<td><strong>Configuration Tag tasks only.</strong> This field is read-only. It indicates whether configuration tag tasks are the only tasks associated with this subject area that will participate in the ETL process. If this check box is selected, the tasks shown in the Tasks child tab will not participate in the ETL process; only the tasks associated with the configuration tag will participate. You set this flag in the Subject Areas parent tab.</td>
</tr>
<tr>
<td>Tasks</td>
<td>This child tab allows you to assign tasks to a configuration tag.</td>
</tr>
</tbody>
</table>
About the DAC Source System Parameters Tab

The Source Systems Parameters tab lists all the source system parameters associated with the selected source system container. It allows you to view and edit existing parameters and to configure new ones. Table 27 provides a description of the properties in the top pane of the tab.

Table 27. Source Systems Parameters Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>The parameter data type. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>Text</td>
</tr>
<tr>
<td></td>
<td>Timestamp</td>
</tr>
<tr>
<td></td>
<td>SQL</td>
</tr>
<tr>
<td>Value</td>
<td>The parameter value.</td>
</tr>
</tbody>
</table>

About the DAC Source System Folders Tab

The Source System Folders tab lists the Informatica folders associated with the selected source system container. It allows you to view existing folders and to create new ones. Table 28 provides a description of the tab properties.

Table 28. Source Systems Parameters Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical Folder</td>
<td>Name of the logical Informatica folder. This name is used in the task definition (in the Tasks tab) so that task definitions do not have to be cloned.</td>
</tr>
<tr>
<td>Physical Folder</td>
<td>Name of the physical Informatica folder. The physical Informatica folder corresponds to the actual folder in the Informatica repository. This name is used in the Ordered Tasks child tab of the Execution Plans tab.</td>
</tr>
</tbody>
</table>

About the DAC Setup View

The Setup View provides access to functionality related to setting up DAC system properties, Informatica servers, database connections, and email notification.

This section includes the following topics:

- About the DAC System Properties Tab on page 107
- About the Informatica Servers Tab on page 111
- About the Physical Data Sources Tab on page 112
- About the Email Recipients Tab on page 114
About the DAC System Properties Tab

The DAC System Properties tab allows you to configure various properties that determine the behavior of the DAC server. Table 29 provides a description of the DAC system properties.

Table 29. DAC System Properties Tab Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze Frequency (in days)</td>
<td>For DAC metadata tables, the frequency (in days) the DAC client automatically updates the table and index statistics for the DAC repository. The value must be numerical.</td>
</tr>
<tr>
<td>Auto Restart ETL</td>
<td>Possible values are True and False.</td>
</tr>
<tr>
<td></td>
<td>When set to True: An ETL that is running when the DAC server abnormally terminates will continue running when the DAC server is restarted.</td>
</tr>
<tr>
<td></td>
<td>When set to False: An ETL that is running when the DAC server abnormally terminates will not automatically restart when the DAC server restarts. The ETL status will be updated to Failed. An administrator will have to manually restart the ETL.</td>
</tr>
<tr>
<td>CreateQueryIndexesAtTheEnd</td>
<td>Possible values are True and False.</td>
</tr>
<tr>
<td></td>
<td>During the ETL process, the DAC server automatically drops and creates indices. When set to True, this property groups all indices of the Query type and creates them after the ETL is complete.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The DropAndCreateIndexes property takes precedence over this property. Therefore, if the DropAndCreateIndexes property is set to False, you cannot set the property CreateQueryIndexesAtTheEnd to True to have indices of the Query type created at the end of the ETL process.</td>
</tr>
<tr>
<td></td>
<td>Also, be aware that when this property is set to True, tables will be analyzed twice. If any indices are marked as Query type indices, and are used by ETL processes, it can adversely affect the performance of the ETL process.</td>
</tr>
<tr>
<td>DAC Alternate Server</td>
<td>Host name of the machine where the alternate DAC server resides. The alternate DAC server is used for failover purposes. The DAC client cannot talk to the alternate server unless the main DAC server is not running.</td>
</tr>
</tbody>
</table>
About the DAC Setup View

DAC Server Host
Host name of the machine where the DAC server resides. You cannot use an IP address for this property.

**NOTE:** The DAC server and a given DAC repository have a one-to-one mapping. That is, you can only run one DAC server against any given DAC repository. Thus, in the repository you must specify the network host name of the machine where the DAC server is to be run.

**NOTE:** This property also takes the value `localhost`. However, this value is provided for development and testing purposes and should not be used in a production environment.

DAC Server OS
Operating system of the machine where the DAC server resides. Possible values are Windows, Solaris, HP, or AIX.

**NOTE:** If you move the DAC server from another operating system to AIX, you need to do the following: change the DAC server host to the appropriate value; restart the DAC client; reenter all the password fields for the Informatica servers and database connections; and reconfigure the DAC server on the AIX machine by running `serverSetupPrompt.sh`.

DAC Server Port
Network port to which the DAC server binds in order to listen to client requests. The default value is 3141. If this port has been assigned to another process, you can enter any numerical port value greater than 1024.

Drop and Create Change Capture Views Always
Possible values are True and False.

When set to True (the default value), the DAC server drops and creates change capture views every time it performs a change capture process, including for both full and incremental loads.

Setting this property to True can create system catalog lock up for DB2-UDB and DB2-390 databases. Therefore, by setting the property to False, the DAC server will drop and create views selectively, using the following rules:

- In full mode:
  - During the change capture phase, views will be dropped and created as full views.
  - During the change capture sync process, incremental views will be generated.

- In incremental mode:
  - If the view exists, it will not be dropped and created.
  - If the view does not exist, the incremental view will be created.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAC Server Host</td>
<td>Host name of the machine where the DAC server resides. You cannot use an IP address for this property. <strong>NOTE:</strong> The DAC server and a given DAC repository have a one-to-one mapping. That is, you can only run one DAC server against any given DAC repository. Thus, in the repository you must specify the network host name of the machine where the DAC server is to be run. <strong>NOTE:</strong> This property also takes the value <code>localhost</code>. However, this value is provided for development and testing purposes and should not be used in a production environment.</td>
</tr>
<tr>
<td>DAC Server OS</td>
<td>Operating system of the machine where the DAC server resides. Possible values are Windows, Solaris, HP, or AIX. <strong>NOTE:</strong> If you move the DAC server from another operating system to AIX, you need to do the following: change the DAC server host to the appropriate value; restart the DAC client; reenter all the password fields for the Informatica servers and database connections; and reconfigure the DAC server on the AIX machine by running <code>serverSetupPrompt.sh</code>.</td>
</tr>
<tr>
<td>DAC Server Port</td>
<td>Network port to which the DAC server binds in order to listen to client requests. The default value is 3141. If this port has been assigned to another process, you can enter any numerical port value greater than 1024.</td>
</tr>
<tr>
<td>Drop and Create Change Capture Views Always</td>
<td>Possible values are True and False. When set to True (the default value), the DAC server drops and creates change capture views every time it performs a change capture process, including for both full and incremental loads. Setting this property to True can create system catalog lock up for DB2-UDB and DB2-390 databases. Therefore, by setting the property to False, the DAC server will drop and create views selectively, using the following rules:</td>
</tr>
</tbody>
</table>

- In full mode:
  - During the change capture phase, views will be dropped and created as full views.
  - During the change capture sync process, incremental views will be generated.

- In incremental mode:
  - If the view exists, it will not be dropped and created.
  - If the view does not exist, the incremental view will be created. |
### Table 29. DAC System Properties Tab Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DropAndCreateIndexes</td>
<td>Possible values are True and False.</td>
</tr>
<tr>
<td></td>
<td>Indicates whether, during the ETL process, the DAC server automatically drops and creates indices.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This property takes precedence over the CreateQueryIndexesAtTheEnd. Therefore, if the DropAndCreateIndexes property is set to False, you cannot set the property CreateQueryIndexesAtTheEnd to True to have indices of the Query type created at the end of the ETL process.</td>
</tr>
<tr>
<td>Dryrun</td>
<td>Possible values are True and False.</td>
</tr>
<tr>
<td></td>
<td>Indicates whether tasks are executed without invoking Informatica workflows. The following processes are executed: change capture, truncation of tables, drop and creation of indices, and analyze statements.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This option should be used for debugging purposes only and not used in a production environment.</td>
</tr>
<tr>
<td>Generic Task Concurrency Limit</td>
<td>Determines how many tasks with execution types other than Informatica can be run concurrently. The value must be numerical.</td>
</tr>
<tr>
<td></td>
<td>To set this value, you should consider what the external tasks do. For example, if the tasks open connections to a database, you should consider how this would affect the preconfigured tasks.</td>
</tr>
<tr>
<td>HeartBeatInterval</td>
<td>Frequency (in seconds) the DAC server checks on the health of the database connections. The value must be numerical. For example, a value of 300 (the default value) indicates the system will perform subsystem diagnostics and recovery procedures every 300 seconds.</td>
</tr>
<tr>
<td>InformaticaFileParameter Location</td>
<td>Directory where the Informatica parameter file is stored.</td>
</tr>
<tr>
<td>Main Informatica Repository</td>
<td>This property is obsolete from Release 7.9 onwards.</td>
</tr>
</tbody>
</table>
About the DAC Setup View

Output Redirect

Indicates whether logging information and standard output and errors are redirected to files in the log directory (when property is set to True). The file containing standard output starts with out_ and ends with the .log extension. The standard error messages are in the file starting with err_ and ending with the .log extension.

If this property is set to False, the logging information is directed to the machine’s standard output and error files, which typically defaults to the console from which the DAC server was launched if the server was launched in a visible console mode. If the server is launched as a Windows service, the logging information is directed to the service log. If the server is launched with the command shell not visible, all logging information is deleted.

Repository Name

Unique name for the DAC repository.

Scheduler.Poll.Interval

Frequency (in seconds) the DAC server polls for changes in the schedule configuration.

Script After Every ETL

The name of the script or executable to be run after every execution plan.

For more information, see the description of the property Script Before Every ETL.

Script Before Every ETL

The name of the script or executable to be run before every execution plan.

For example, before running an execution plan, you might want to run a process or perform certain tasks. These can be contained in a script or executable. This file should be placed in the scripts subdirectory of the DAC server.

The execution plan runs only after the external process has finished. Therefore, it is important that the script or executable does not fail.

Server Log Level

Output logging level. Possible values are Finest, Finer, Fine, Config, Info, Warning, and Severe. The Severe value produces minimal log details, and Finest produces the most extensive amount of reporting.

SQL Trace

Possible values are True and False.

Indicates whether the SQL statements to the DAC repository and database connections are added to the log file. Possible values are True and False. The True value sends a hint to the database connectivity layer of the DAC server to enable SQL tracing; thus, every SQL statement that is run by the DAC server is spooled to the appropriate output log file.

It is recommended that you set this property to False.
About the DAC Setup View

Oracle Business Intelligence Data Warehouse Administration Console Guide
Version 7.9

About the Informatica Servers Tab

The Informatica Servers tab allows you to register one or more Informatica servers and one Informatica Repository server and to specify how many workflows can be executed in parallel on each server. The DAC server automatically load balances across the servers. Table 30 describes the properties of the tab.

Table 30. Informatica Server Tab Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of Informatica Server or Informatica Repository Server.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of server:</td>
</tr>
<tr>
<td></td>
<td>■ Informatica. The Informatica Server.</td>
</tr>
<tr>
<td></td>
<td>■ Repository. The Informatica Repository Server.</td>
</tr>
<tr>
<td>Server Hostname</td>
<td>The host machine name where the Informatica Server or Informatica Repository Server is installed.</td>
</tr>
<tr>
<td>Server Port</td>
<td>Port number used by the Informatica Server or Informatica Repository Server to listen to requests.</td>
</tr>
<tr>
<td>Login</td>
<td>Informatica Repository user login.</td>
</tr>
<tr>
<td>Password</td>
<td>Informatica Repository password.</td>
</tr>
<tr>
<td>Maximum Sessions</td>
<td>The maximum number of workflows that can be executed in parallel on the Informatica Server.</td>
</tr>
<tr>
<td>Repository Name</td>
<td>Informatica Repository name.</td>
</tr>
</tbody>
</table>

NOTE: You deploy only one Informatica Repository Server, but you can deploy multiple Informatica Servers.
Actions Available
The following actions are available in the top pane toolbar and in the right-click menu when the Informatica Servers tab is active.

Test Connection
This command allows you to test whether the Informatica Server or Informatica Repository Server is running. The DAC client will attempt to delegate the test to the DAC server. If the DAC server is not running, you will be asked whether you want to test the connection on the local client machine. The results of a test on the local client machine may not be true for the DAC server environment.

About the Physical Data Sources Tab
The Physical Data Sources tab provides access to the connection properties for the physical data sources. In this tab, you can view and edit existing physical data source connections and create new ones. Table 31 provides a description of the physical data source properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Logical name for the physical data source.</td>
</tr>
<tr>
<td>Type</td>
<td>Physical data source type. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>Source</td>
</tr>
<tr>
<td></td>
<td>Warehouse</td>
</tr>
<tr>
<td></td>
<td>Informatica Repository</td>
</tr>
<tr>
<td></td>
<td>DAC Repository</td>
</tr>
<tr>
<td></td>
<td>Other</td>
</tr>
<tr>
<td>Connection Type</td>
<td>Type of database connection. Possible values are the following:</td>
</tr>
<tr>
<td></td>
<td>Oracle (OCI8). Connect to Oracle using the tnsnames entry.</td>
</tr>
<tr>
<td></td>
<td>Oracle (Thin). Connect to Oracle using thin driver.</td>
</tr>
<tr>
<td></td>
<td>DB2. DB2 UDB database.</td>
</tr>
<tr>
<td></td>
<td>DB2-390. DB2 390 database.</td>
</tr>
<tr>
<td></td>
<td>MSSQL. Microsoft SQL Server.</td>
</tr>
<tr>
<td></td>
<td>Teradata. Teradata database.</td>
</tr>
<tr>
<td></td>
<td>Flat File</td>
</tr>
</tbody>
</table>
Table 31. Physical Data Sources Top Pane Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection String</td>
<td>If you are using...</td>
</tr>
<tr>
<td></td>
<td>■ Oracle (OCI8), use the tnsnames entry.</td>
</tr>
<tr>
<td></td>
<td>■ Oracle (Thin), use instance name.</td>
</tr>
<tr>
<td></td>
<td>■ SQL server, use the database name.</td>
</tr>
<tr>
<td></td>
<td>■ DB2-UDB/DB2-390, use the connect string as defined in the DB2 configuration.</td>
</tr>
<tr>
<td></td>
<td>■ Teradata, use the database name.</td>
</tr>
<tr>
<td>Table Owner</td>
<td>Name of table owner.</td>
</tr>
<tr>
<td>Max Num Connections</td>
<td>Maximum number of database connections this connection pool can contain.</td>
</tr>
<tr>
<td></td>
<td>For information about determining how to set this value, see “Determining the Number of Transactional and Data Warehouse Database Connections” on page 75</td>
</tr>
<tr>
<td>DBHost</td>
<td>Host machine where the database resides. This field is mandatory if you are using Oracle (Thin), MSSQL, or Teradata, but is not required if you are using Oracle (OCI8), DB2, or DB2-390.</td>
</tr>
<tr>
<td>Port</td>
<td>Port where the database receives requests. Required for Oracle (Thin) and MSSQL databases. Not required for Oracle (OCI8), DB2, or DB2-390, or Teradata databases.</td>
</tr>
<tr>
<td>Priority</td>
<td>User-defined priority of the data source.</td>
</tr>
<tr>
<td>Data Source Number</td>
<td>User-defined number of the data source.</td>
</tr>
<tr>
<td>Default Index Space</td>
<td>Applicable to Oracle databases only. The default index space for the physical data source. When indices are dropped and created, they are created in this index space.</td>
</tr>
</tbody>
</table>

Table 32 provides a description of the child tabs in the bottom pane of the Physical Data Sources tab.

Table 32. Physical Data Sources Child Tab

| Refresh Dates          | During an ETL process, this date is captured for all target tables and source tables of the type primary and auxiliary. The DAC uses this date in the change capture process, during parameter generation, when choosing between full and incremental loads, and when deciding whether to truncate a table. (Does not apply to micro ETL processes.) |
|                       | **NOTE:** Refresh dates for micro ETL processes are captured in the Refresh Dates child tab of the Execution Plans tab. |
**Actions Available**

The following actions are available in the top pane toolbar and in the right-click menu when the Physical Data Sources tab is active.

**Test Connection**

This command allows you to test the connection to the database. The DAC client will attempt to delegate the test to the DAC server. If the DAC server is not running, you will be asked whether you want to test the connection on the local client machine. The results of a test on the local client machine may not be true for the DAC server environment.

**About the Email Recipients Tab**

This tab allows you to set up a list of email addresses that will be notified about the status of the ETL process. Table 33 describes the properties in this tab.

Table 33. Email Recipients Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Logical name of the user to be notified.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Email address where the notification is sent.</td>
</tr>
<tr>
<td>Notification Level</td>
<td>The notification levels are as follows:</td>
</tr>
<tr>
<td></td>
<td>■ 10 -- Notifies recipient of success or failure of each task.</td>
</tr>
<tr>
<td></td>
<td>■ 5  -- Notifies recipient of success of failure of the entire ETL process.</td>
</tr>
<tr>
<td></td>
<td>■ 1  -- Notifies recipient that ETL completed successfully.</td>
</tr>
</tbody>
</table>

**About the DAC Execute View**

The Execute View provides access to functionality that allows you to run, schedule, and monitor execution plans.

This section includes the following topics:

- About the DAC Execution Plans Tab on page 115
- About the DAC Current Run Tab on page 119
- About the DAC Run History Tab on page 122
- About the DAC Scheduler Tab on page 122
About the DAC Execution Plans Tab

The Execution Plans tab allows you to view and edit existing execution plans and to create new ones. Table 34 provides a description of the properties in the top pane of the tab.

Table 34. Execution Plans Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Load Always</td>
<td>Indicates the specified ETL process will always execute a full load.</td>
</tr>
<tr>
<td>Keep Separate</td>
<td>Used for micro ETL processes. Indicates refresh dates are kept separate for each run of the execution plan.</td>
</tr>
<tr>
<td>Refresh Dates</td>
<td></td>
</tr>
<tr>
<td>Prune Days</td>
<td>When the source system is Oracle’s Siebel CRM applications, the LAST_UPD column in the transactional database tables is used for incremental change capture. This timestamp reflects the actual event time. It is therefore possible for a data row to be committed to the transactional database with a LAST_UPD date that is older than the date on which the last refresh was executed. This will cause the data row to be missed in the subsequent extract (if based purely on LAST_UPD date). However, the LAST_UPD date column still provides an opportunity to improve the change capture process by overlapping the extraction date window by the number of days set in this parameter. The records extracted in the overlapped window are filtered by comparing this information with information in the Image table. The Prune Days setting ensures that the rows that had values in LAST_UPD older than values in LAST_REFRESH_DATE are not missed. This is a parameter that can be set based on experience with processes, such as remote sync, that potentially can cause records to be missed. This parameter cannot be less than 1. For example: Assume the table W_PERSON_D was refreshed on January 15th by querying the table S_CONTACT. And, the Prune Days setting was set to 5. The next time S_CONTACT is queried to load W_PERSON_D, the records that have a LAST_UPD value since January 10 are compared with the ROW_ID of the Image table to cover for any missing records between January 15 and January 10 (the overlap period). For source systems other than Siebel, the Prune Days setting is used in the same way except that the DAC substracts the number of prune days from the LAST_REFRESH_DATE of a given source and supplies this as the value for the $$LAST_EXTRACT_DATE parameter.</td>
</tr>
<tr>
<td>Last Designed</td>
<td>Date this execution plan was last designed.</td>
</tr>
<tr>
<td>Analyze</td>
<td>Indicates the tables associated with this execution plan will be analyzed.</td>
</tr>
</tbody>
</table>
Table 34. Execution Plans Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze Truncated Tables Only</td>
<td>Indicates only truncated tables will be analyzed.</td>
</tr>
<tr>
<td>Drop/Create Indices</td>
<td>Indicates indices of the tables associated with this execution plan will be dropped and created.</td>
</tr>
</tbody>
</table>

Table 35 provides a description of the child tabs in the bottom pane of the Execution Plans tab.

Table 35. DAC Execution Plans Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject Areas</td>
<td>Displays the subject areas associated with the selected execution plan. You can also add subject areas to the selected execution plan.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Displays the selected execution plan’s parameters for database connections and Informatica folders. It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Type. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>■ Folder. Indicates an Informatica folder.</td>
</tr>
<tr>
<td></td>
<td>■ Datasource. Indicates a database connection parameter.</td>
</tr>
<tr>
<td></td>
<td>■ Name. Logical name of the folder or database connection.</td>
</tr>
<tr>
<td></td>
<td>■ Value. Physical name of the folder or database connection.</td>
</tr>
<tr>
<td></td>
<td>■ Source System. Name of the source system associated with the parameter.</td>
</tr>
<tr>
<td>Preceding Tasks</td>
<td>Displays the tasks that must be completed before an ETL process is executed. Also allows you to add preceding tasks.</td>
</tr>
<tr>
<td></td>
<td>It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Priority. Indicates the order in which the task runs. If two or more tasks have the same priority, the DAC will run them in parallel.</td>
</tr>
<tr>
<td></td>
<td>■ Inactive. Indicates the task is inactive.</td>
</tr>
<tr>
<td></td>
<td>■ Command. Command associated with the task.</td>
</tr>
<tr>
<td></td>
<td>■ Source System. Source system container from which the task extracts data.</td>
</tr>
<tr>
<td>Following Tasks</td>
<td>Displays the tasks that must be completed after an ETL is executed. Also allows you to add tasks.</td>
</tr>
<tr>
<td></td>
<td>It includes the same properties as the Preceding Tasks child tab.</td>
</tr>
</tbody>
</table>
### Ordered Tasks
Displays tasks associated with the selected execution plan and the order in which they can be executed. It includes the following properties:

- **Depth.** The level of the task’s dependency. Tasks that have no dependencies are depth 0. Tasks that depend on other tasks of depth 0 are depth 1, and so on.
- **Primary Source.** Primary source table from which the task extracts data.
- **Primary Target.** Primary target table into which data is loaded.
- **Folder Name.** Name of the Informatica folder in which the task resides.
- **Task Phase.** Task phase of the ETL process. The DAC server uses the task phase to prioritize tasks and to generate a summary of the time taken for each of the phases.
- **Command.** Command associated with the task
- **Source System.** Source system container from which the task extracts data.

The Details button opens a dialog box that contains the following information about the selected task:

- All Predecessors
- All Successors
- Immediate Predecessors
- Immediate Successors
- Source Tables
- Target Tables
- Conditional Tables

### Immediate Dependencies
Displays the immediate dependent relationship between tasks that are generated during the automatic task generation process.

It includes the following properties:

- **Task (Calculated).** Shows the named task’s source and target.
- **Predecessor Name.** Predecessor task for the named task.
- **Predecessor (Calculated).** Shows the source and target of the predecessor task.

---

**Table 35. DAC Execution Plans Child Tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordered Tasks</td>
<td>Displays tasks associated with the selected execution plan and the order in which they can be executed. It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>- Depth. The level of the task’s dependency. Tasks that have no dependencies are depth 0. Tasks that depend on other tasks of depth 0 are depth 1, and so on.</td>
</tr>
<tr>
<td></td>
<td>- Primary Source. Primary source table from which the task extracts data.</td>
</tr>
<tr>
<td></td>
<td>- Primary Target. Primary target table into which data is loaded.</td>
</tr>
<tr>
<td></td>
<td>- Folder Name. Name of the Informatica folder in which the task resides.</td>
</tr>
<tr>
<td></td>
<td>- Task Phase. Task phase of the ETL process. The DAC server uses the task phase to prioritize tasks and to generate a summary of the time taken for each of the phases.</td>
</tr>
<tr>
<td></td>
<td>- Command. Command associated with the task</td>
</tr>
<tr>
<td></td>
<td>- Source System. Source system container from which the task extracts data.</td>
</tr>
<tr>
<td></td>
<td>The Details button opens a dialog box that contains the following information about the selected task:</td>
</tr>
<tr>
<td></td>
<td>- All Predecessors</td>
</tr>
<tr>
<td></td>
<td>- All Successors</td>
</tr>
<tr>
<td></td>
<td>- Immediate Predecessors</td>
</tr>
<tr>
<td></td>
<td>- Immediate Successors</td>
</tr>
<tr>
<td></td>
<td>- Source Tables</td>
</tr>
<tr>
<td></td>
<td>- Target Tables</td>
</tr>
<tr>
<td></td>
<td>- Conditional Tables</td>
</tr>
<tr>
<td>Immediate Dependencies</td>
<td>Displays the immediate dependent relationship between tasks that are generated during the automatic task generation process.</td>
</tr>
<tr>
<td></td>
<td>It includes the following properties:</td>
</tr>
<tr>
<td></td>
<td>- Task (Calculated). Shows the named task’s source and target.</td>
</tr>
<tr>
<td></td>
<td>- Predecessor Name. Predecessor task for the named task.</td>
</tr>
<tr>
<td></td>
<td>- Predecessor (Calculated). Shows the source and target of the predecessor task.</td>
</tr>
</tbody>
</table>
About the DAC Execute View

Actions Available
The following actions are available in the top pane toolbar and in the right-click menu when the Executions Plan tab is active.

Run Now Command
This command submits a request to the DAC server to execute the execution plan. Inactive execution plans are not included in the process.

When an execution plan is run, the following logic is used to identify the tasks that need to be run and their order of execution.

1. Check on the previous run status.
   a. If the previous run executed a different execution plan from the one currently submitted (either manually or through the scheduler), abort the run.
   b. If the previous run executed is the same as the current execution plan and did not complete, continue from where it left off.
   c. If the previous run has completed, create a new run.

2. Check resources.
   a. If the DAC server cannot establish connections to the databases defined for that execution plan, abort the run.
   b. If there are no Informatica servers registered, abort the run.
   c. If the Informatica servers are registered and the DAC server is unable to ping them, abort the run.

3. Select initial tables.
   a. Find all the subject areas.

4. Select initial tasks: Find all the tasks that load into the above selected tables. (Tasks whose target table is one of the selected tables and that are non-optional.)

5. Recursively select all tasks. Depending on the non-optional dependency rules, figure out the prerequisite tasks recursively.

---

Table 35. DAC Execution Plans Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Dependencies</td>
<td>Displays the dependent relationship for all tasks. The columns are the same as the Immediate Dependencies child tab.</td>
</tr>
<tr>
<td>Refresh Dates</td>
<td>Applies to micro ETL execution plans (indicated by selecting the Keep Separate Refresh Dates check box in the Execution Plans tab).</td>
</tr>
</tbody>
</table>
  - Connection. Logical name for database connection. |
  - Refresh Date. Last refresh time of the execution plan. This applies only when separate refresh dates are maintained. Used for micro ETL processing. |
6. Select optional tasks (with the tasks already chosen).

7. Select dependencies: Load dependencies and compute for each task the number of all Depends On tasks. This number will be decremented for tasks higher up in the hierarchy as each of the tasks complete. When the number of Depends On tasks reaches zero, the task itself will become eligible to be run.

8. Identify the task details. Iterate through all the tasks selected, compute the task dependencies.

9. Identify the list of source tables for change capture and create tasks for change capture and sync for Siebel sources. Iterate through all the tasks and find the primary or auxiliary tables and group them by source database connection.

10. Execute pre-ETL tasks. If there are errors, stop the run.

11. Execute the change capture process. If there are errors, stop the process.

12. Execute the dependency graph. If there are errors, stop all the tasks that depend on the failed tasks. Continue to execute all others, until there are no more to run, and then stop.

13. Execute the change capture sync process. If there are errors, stop the process.

14. Execute the post-ETL process. If there are errors, stop the process.

15. At the end of the ETL process, the DAC server updates refresh timestamps for all source tables (primary or auxiliary) and target tables. The refresh timestamps are the database timestamps. The ETL history timestamps (Start and End timestamps) are the DAC server timestamps.

### About the DAC Current Run Tab

This tab displays a list of queued, running, and failed current ETL processes in the top pane. This list includes comprehensive information about each process.

Table 36 provides a description of the information provided in the top pane.

**NOTE:** Once an ETL process completes, it is accessible from the Run History tab.

Table 36. Current Run Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Plan Name</td>
<td>The execution plan whose runtime instance is this record. This field is read only.</td>
</tr>
<tr>
<td>Process ID</td>
<td>ID for the process. This value is an integer that is incremented by 1 for every run. This value is stored as ETL_PROC_WID in all the data warehouse tables. This field is read only.</td>
</tr>
</tbody>
</table>
Table 36. Current Run Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Status</td>
<td>Status of the run. The possible values are the following:</td>
</tr>
<tr>
<td></td>
<td>■ Queued. Tasks for which the Depends On tasks are not yet completed. Displayed in yellow in the Current Run list.</td>
</tr>
<tr>
<td></td>
<td>■ Runnable. Tasks for which the Depends On tasks have completed and are ready to be run but are waiting for an Informatica slot to be available.</td>
</tr>
<tr>
<td></td>
<td>■ Running. Tasks for which the Depends On tasks have been completed, have gotten an Informatica slot, and are being executed. Displayed in blue.</td>
</tr>
<tr>
<td></td>
<td>■ Paused. Task group members that are waiting for the other tasks in the group to be executed.</td>
</tr>
<tr>
<td></td>
<td>■ Failed. Tasks that were executed but encountered a problem. Displayed in red.</td>
</tr>
<tr>
<td></td>
<td>■ Stopped. Tasks for which one or more Depends On tasks have failed.</td>
</tr>
<tr>
<td></td>
<td>■ Completed. All tasks have completed without errors. Displayed in green.</td>
</tr>
<tr>
<td>Total Number of Tasks</td>
<td>Total number of tasks for this run. This field is read only.</td>
</tr>
<tr>
<td>Number of Failed Tasks</td>
<td>Sum total of tasks that have failed and that have stopped. This field is read only.</td>
</tr>
<tr>
<td>Number of Successful Tasks</td>
<td>Number of tasks whose status is completed. This field is read only.</td>
</tr>
<tr>
<td>Number of Tasks Still in Queue</td>
<td>Number of tasks whose prerequisite tasks have not completed, and the number of tasks whose prerequisite tasks are completed and are waiting for resources. This field is read only.</td>
</tr>
<tr>
<td>Start Timestamp</td>
<td>Start time of the ETL. Reflects the start time of every ETL attempt. For example, if the ETL fails and is run again, it gets a new start timestamp. The history of attempted runs is maintained in the audit trail for the run. This field is read only.</td>
</tr>
<tr>
<td>End Timestamp</td>
<td>End time of the ETL. Reflects the end time of every ETL attempt. For example, if the ETL fails and is run again, it gets a new end timestamp when the ETL is complete. The history of attempted runs is maintained in the audit trail for the run. This field is read only.</td>
</tr>
<tr>
<td>Duration</td>
<td>A calculated field that shows the difference between start and end time stamps.</td>
</tr>
<tr>
<td>Status Description</td>
<td>Displays messages generated during run time. You can add notes to this field for Completed runs.</td>
</tr>
<tr>
<td>Schedule Name</td>
<td>Name of a scheduled ETL process.</td>
</tr>
</tbody>
</table>
Table 37 provides a description of the tabs in the bottom pane.

Table 37. Current Run Child Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tasks</td>
<td>Displays runtime instances of the tasks. As the execution proceeds, the tasks are executed based on the dependency rules and some prioritization.</td>
</tr>
<tr>
<td></td>
<td>As tasks complete, the tasks that depend on the completed tasks are notified and once their dependencies are completed, they become eligible to run. If a task fails, the administrator can address the failure and then requeue the task or mark it as completed. The DAC server polls for any changes in the failed task’s detail status. If a failed task detail is queued, the task itself gets back into the ready to run queue and all its dependent tasks get into the queued status.</td>
</tr>
<tr>
<td></td>
<td>The rules of prioritization are as follows:</td>
</tr>
<tr>
<td></td>
<td>■ Tasks with no dependencies are executed first.</td>
</tr>
<tr>
<td></td>
<td>■ If a task has failed and has been requeued, it gets the maximum priority.</td>
</tr>
<tr>
<td></td>
<td>■ Tasks with greater phase priorities are executed next. When several tasks of the same phase are eligible to run, the tasks with greater task priorities are executed next.</td>
</tr>
<tr>
<td>Summary (Read Only)</td>
<td>Provides a summary (based on dynamic SQL) of the selected ETL. A start and end time for each phase is included.</td>
</tr>
<tr>
<td>Task Details</td>
<td>Provides a execution details about each task associated with the selected ETL.</td>
</tr>
<tr>
<td>Audit Trail (Read Only)</td>
<td>Provides the history of the selected ETL.</td>
</tr>
</tbody>
</table>

**Actions Available**

The following actions are available in the top pane toolbar and in the right-click menu when the Current Run tab is active.

**Start**

This command restarts the selected ETL, after the ETL has failed, stopped, or been aborted.

**Abort**

This command causes an ETL in progress to abort. All currently running tasks will be aborted. The status of queued tasks and the ETL itself will change to Stopped.
**Auto Refresh**
This command allows you to turn on and off the automatic screen refresh functionality and set the refresh interval.

**Get Log File**
This command fetches the log file for this run from the DAC server and saves it in the ServerLog folder.

**Mark as Completed**
This command changes the status of a stopped or failed ETL to Completed. In the audit trail for this ETL, the status is Marked as Completed. Use this command with caution; it can cause the data warehouse to be inconsistent.

**Analyze Run**
This command saves a description of the run as an HTML file in the Log/Statistics folder.

### About the DAC Run History Tab
The Run History tab displays information about completed ETL processes. The information displayed in the top and bottom panes is the same as in the Current Run tab. For a description of the information displayed in the Run History tab and the actions available, see “About the DAC Current Run Tab” on page 119.

### About the DAC Scheduler Tab
The Scheduler tab allows you to schedule ETL processes to be run either once at a later time or periodically. When you schedule an ETL or make changes to a schedule, the DAC server picks up the information from the DAC client. The DAC server polls the DAC repository for changes periodically at a frequency set in the DAC system properties.

The top pane of the Scheduler tab lists ETL processes that have been scheduled. The bottom pane allows you to schedule an ETL process. Table 38 provides a description of the information displayed in the top pane.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Plan</td>
<td>Execution plan scheduled.</td>
</tr>
<tr>
<td>Last Schedule Status</td>
<td>The last run status of the scheduled ETL process. Possible values are Running, Completed or Stopped.</td>
</tr>
<tr>
<td>Next Trigger</td>
<td>Time the scheduled ETL process will next run.</td>
</tr>
</tbody>
</table>
Table 38. DAC Scheduler Tab Top Pane Properties

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Description</td>
<td>Description of the last ETL run. Possible values are Running, Completed, or the reason the process stopped.</td>
</tr>
<tr>
<td>Recurrence</td>
<td>Indicates how often the schedule will be run.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Indicates whether the schedule is inactive.</td>
</tr>
</tbody>
</table>
## Index

### C
- change capture
  - about 78
  - filter 84
- configuration tags
  - working with 51

### D
- DAC repository
  - command line options 70
- DAC server
  - command line access 66
  - monitor icons 33
  - running automatically 65
- data flow
  - Online Analytical Processing (OLAP) database, about and diagram 11
- data warehouse
  - architecture 10
  - overview 9
- Data Warehouse Administration Console (DAC)
  - about 12
  - Current Run tab 119
  - DAC features 14
  - DAC window 22
  - Design view 89
  - editable lists 34
  - Email Recipients tab 114
  - Execute view 114
  - Execution Plans tab 115
  - exporting metadata 64
  - importing metadata 63
  - Indices tab 94
  - Informatica Servers tab 111
  - menu bar 23
  - navigation tree 34
  - object ownership 38
  - Physical Data Sources tab 112
  - process life cycle 17
  - repository objects, about 16
  - Run History tab 122
  - starting DAC client 19
  - System Properties tab 107
  - Tables tab 92
  - Tasks tab 97
  - top pane toolbar 27
  - user interface 22
- deleted records
tracking 84

E
execution plan
micro ETL 58
monitoring processes 61
scheduling 60

F
flat views
querying 37

I
Informatica
mappings, creating 46
replacing workflow with SQL file 72
server sessions 73
Informatica repository
importing objects 46

O
Online Analytical Processing database
Data Warehouse, data flow into 11
Oracle Business Analytics Data Warehouse
overview 9
Oracle Business Analytics Warehouse
adding columns 44
adding indices 46
adding new table 44
architecture 10
architecture components 11
customizing 42
overview 9

Q
query functionality
flat views querying 37
query commands 35
query operators 35
query procedures 36

R
refresh dates
about 60
right-click menu
common commands 29
Design view commands 30
Execute view commands 32
Setup view commands 31
S
source system container
  about  15
  copying  41
  creating  41
source system parameters
  setting  49
SQL files
  using as execution type  77
subject area
  creating  56
  designing  54
T
task group
  creating  49
task level parameters
  setting  50
task phase dependency
  setting  48
Tasks
  creating tasks for workflows  47